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I General 

I.1 About this Manual 

This manual describes the hardware, software and usage of the ICMflex in its current version including all 
available configurations. Some of the hardware features of the most recent versions are not available with 
earlier versions of the instrument. It is possible to upgrade most of the previous instruments to the features 
of the current instruments. Please contact Power Diagnostix for details.  

Software updates are available through Power Diagnostix's website (www.pdix.com). The access to the 
download area of that website is password protected and requires a valid software maintenance contract. 
Contact Power Diagnostix for details. Current brochures and revisions of this manual are available for 
download (PDF format) on that website as well. 

I.2 Instrument Safety 

Before using the ICMflex, read the following safety information in this manual carefully. Especially read and 
obey the information, which are marked with the words 'Warning' and 'Caution'. The word 'Warning' is re-
served for conditions and actions that pose hazards to the user, while the word 'Caution' is reserved for 
conditions and actions that may damage the instrument, or its accessories, or that may lead to malfunction. 

Always obey the safety rules given with the warnings and with this chapter. Especially take care of the safe-
ty issues while performing field measurements. Never disregard safety considerations even under time con-
straints found often with on-line and off-line test on site. 

 

 

Warning: 
 

• Always provide solid grounding of the instrument. Use the rear side wing nut terminal for 
ground connection on the ground plate or the multi-contact connectors beside. Never oper-
ate the instrument without protective grounding. 

• Avoid working alone. 

• Do not allow the instrument to be used if it is damaged or its safety is impaired. 

• Inspect the ground leads and signal cables for continuity. 

• Select the proper coupling circuit and connection for your application. 

• Do not use the instrument in explosion endangered environment. 

• Use the fiber optic link or the Bluetooth communication to operate the instrument. Do not use 
any cable not supplied by Power Diagnostix. 

! 
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I.3 Health and Safety Recommendations 

I.3.1 General Safety Procedure Prior to Commence 

When working under high voltage conditions, following topics need to be considered strictly prior to the 
measurement set-up and testing. 

1.) The operators must have read the safety instructions and passed the local site safety instructions 
regarding health and possible hazards. 

2.) The sample to be tested must be offline, de-energized, and grounded. 

3.) Each operator has to check the safety conditions together with the site responsible and pass the ta-
gout/lockout procedure for the specimen to be tested. 

4.) After the tagout/lockout procedure, the specimen needs to be checked for the presence of voltage 
together with the site responsible by using a suitable HV tester. 

5.) The operator has to check the solid work grounding together with the site responsible. 

6.) After passing issues 1 to 5, the specimen is in safe condition and may be connected to the equip-
ment. 

7.) Check for a safe area as close as possible to the specimen terminals to install the equipment. 

8.) Apply demarcation around the full measurement set-up and make use of a safety guard, if neces-
sary. 

9.) Prevent working alone. 

10.) Only authorized personnel are allowed to access the demarcated test area. 

11.) Hold a meeting with other people working close to the hazardous area before energizing the test 
specimen. 

12.) Please check at least the insulation resistance prior to apply external HV potential. 

13.) The calibration can be performed. 

14.) Remove the calibrator before applying any external high voltage. 

15.) Record the requested data and ensure slow and careful voltage ramp-up steps. 

16.) Discharge and ground the test specimen after the external high voltage is switched off. 

17.) Test the specimen for the presence of high voltage before changing or touching any HV connection 
with a grounding stick. 

18.) The specimen is now in safe condition, necessary changes to the set-up can be done safely. 

Please check the detailed Power Diagnostix “Health and Safety Instructions and Recommendations” guide-
line in case of any ambiguities regarding safety. 
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I.3.2 Health and Safety Risks 

Incautious actions during testing can result in life-threatening hazards such as electrocution. Please be 
aware that is not only valid for the operators but also for other people working close to the area under high 
voltage. Please take the necessary personal protection recommendations as mentioned above and in the 
detailed Power Diagnostix “Health and Safety Instructions and Recommendations” guideline so that testing 
can be performed in a safe condition at any time. 

A specimen under high voltage can produce Ozone due to the presence of partial discharge activity. The 
maximal allowed Ozone concentration in the open air is fixed on 0.1 ppm (parts per million) in accordance 
with the European Health commission. Inhaling to much Ozone can cause serious lung problems on short- 
and/or on long-term. Please make sure that the test area is sufficiently ventilated. When necessary, make 
use of any required personal protection equipment, and hence, consider this health recommendation during 
testing. 

I.3.3 Environmental Conditions 

Care must be taken that the area surrounding the test specimen is in sufficiently clean and dry condition 
before installing the equipment and starting the tests. We recommend considering particularly the tempera-
ture and relative humidity. Temperatures above 45°C can directly affect the performance of the battery. 
Working under too high humidity conditions can result in additional stray capacitances influencing the tan 
delta and capacitance values, even the partial discharge measurement. Always make sure that the equip-
ment is clean and leave sufficient space between the parts under high voltage and any other object nearby. 
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II Principle of Operation 

The ICMflex is a unique measurement system that covers PD detection, PD fault location on cables, and 
tanδ measurements (standard ICMflex, only). It has been designed to simplify the application and to com-
bine different measurement tasks with one instrument. This new principle minimizes testing and operation 
time, increases operator's safety, and guarantees highest sensitivity and precision. Main users of these 
systems are: 

- Service groups testing motors, generators, and accessories of the same 
- Service groups testing high voltage cables, termination and joints 
- Maintenance & repair shops 
- High voltage laboratories 
- Research & development departments 

The system is mainly used for on-site testing, but can be used in laboratories and workshops as well. It 
operates with any fixed or portable high voltage power supply, like transformers, high pots, resonant test 

systems, motor generator sets, and VLF sys-
tems (cos/square & sine waves), for instance. 
Power Diagnostix offers complete systems as 
well as modular components. 

A complete acquisition system is shown here 
in figure 1. It consists of a reference capacitor 
Cn, two shunt capacitors Csn and Csx, a decou-
pling circuit for PD measurement, an HF cur-
rent transformer, and the acquisition box with 
battery module. If PD measurement is not 
wanted, the decoupling circuit will not be built-
in. For systems above 30 kV the main box is 
surrounded by an aluminum electrode to 
smoothen the electrical field. The communica-
tion from a laptop to the instrument can be 
established via Bluetooth or via fiber optic se-
rial bus. All measurement values are displayed 
by the ICMflex remote control software on the 
computer. 

Two voltages can be measured with this sys-
tem. Ux is taken from the capacitive divider 
between the external capacitance of the test 
object Cx and the internal shunt capacitor Csx. 
The reference voltage Un is provided by the 
capacitive divider Cn/Csn. The waveform of 
both voltages is displayed in a special graph in 
parallel with the absolute values of Upeak, Urms, 
and Upeak/sqrt2. The correlation of both signals 
gives further results like the tan delta value, 
the power factor, and the capacitance Cx of the 
sample under test. Due to the high sampling 
rate of 100 MHz with a 16 bit A/D conversion 
sufficient precision and accuracy can be guar-
anteed. 

The high frequency PD signal is used for PD 
pattern acquisition and for PD fault location on cables as well, if needed. The PD scope comes with an 8bit 
resolution vs. phase and amplitude. The pulse counting goes up to 65536 (16 bit) per phase-amplitude posi-

+
-

+ +

+ +

Fig. 1: Design of the ICMflex 
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tion. The sensitivity of PD measurements depends strongly on the quality of the power supply. Power 
Diagnostix offers various modular filter units to block noise generated by the source (see section III.5). Fur-
thermore, the instrument comes with a built-in gating input to trigger on HF pulses from the input side. Ex-
ternal noise signals do not interfere with the measurements as all signals are directly taken on high voltage 
potential and, therefore, critical ground loops to the instrument are not existent. 

The following table shows the most common combinations and configurations of the ICMflex. Adaptable 
high voltage filters are available for all systems. 

Type Rated Voltage 
Ur (RMS) 

Rated 
Current 
Ir (RMS) 

Frequency 
Range 
f 

Reference 
Capacitor 
Cn 

Shunt 
Capacitor 
Csn 

Shunt 
Capacitor 
Csx 

Comment 

IC
M

fle
x 

20 kV 1A 2–265 Hz 1000 pF 2 µF 5µF/30µF  

30 kV 5 A 2–265 Hz 1000 pF 3 µF 10µF/100µF  

30 kV 100 mA 0.02–0.2 Hz 
(2–265 Hz) 1000 pF 3 µF 40µF/400µF  

50 kV 1 A 2–265 Hz 500 pF 2.5 µF 10µF/100µF  

50 kV 100 mA 0.02–0.2 Hz 
(2–265Hz) 500 pF 4 µF 40µF/400µF  

100 kV 1 A 2–265 Hz 1000 pF 10 µF 10µF/100µF  

100 kV 100 mA 0.02–0.2 Hz 
(2–265 Hz) 1000 pF 10 µF 40µF/400µF  

150 kV 1 A 2–265 Hz 1000 pF 15 µF 10µF/100µF  

150 kV 100 mA 0.02–0.2 Hz 
(2–265 Hz) 1000 pF 15µF 40µF/400µF  

20 kV–1000 kV to be 
specified 2–265 Hz to be 

specified 
to be 
specified 

to be 
specified 

available on 
request 

Typical filter units are listed in the table below. Please contact Power Diagnostix if modified versions are 
needed. 

Type Rated 
Voltage 
Ur (RMS) 

Rated 
Current 
Ir (RMS) 

Frequency 
Range 
f 

Filter 
Config. 

Blocking 
Capacitor 
Cb 

Damping 
Factor 
@100 kHz 

Comment 

T30/1 30 kV 1 A DC–300 Hz L-C-L 6.7 nF >100  

T50/1 50 kV 1 A DC–300 Hz L-C-L 10 nF >100  

T100/1 100 kV 1 A DC–300 Hz L-C-L 10 nF >100  

T100/70 100 kV 70 A DC–300 Hz L-C-L 10 nF >100  

T150/1 150 kV 1 A DC–300 Hz L-C-L 10 nF >100  
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The following picture shows a 50 kV set consisting of a T-filter T50/1 (left) and the ICMflex model for 50 kV 
(right). 

Due to the different needs, it is possible to order the ICMflex acquisition system in different configurations. 
The following table illustrates this modularity. Please contact Power Diagnostix to specify the individual 
configuration. 

Type Comment 

ICMflex 
Basic system 

The basic system offers voltage measurement, frequency measurement, and both 
communication ports like Bluetooth and fiber optic serial transmission. The black acqui-
sition box is placed in the head of the gray case. The system is not usable without one 
of the following options. 

ICMflex 
Option TD 

This option enables all features for loss factor measurements. The system will come with 
customized shunt and reference capacitors. The software calculates the following values: 
Cx : Capacitance of the test object 

tanδ : Loss factor of the sample under test 

cos ϕ : Power factor of the sample under test 
Optionally, the system can be fitted with a Cx bypass to avoid overstressing of the shunt 
capacitor if the test object's capacitance is too high. 

ICMflex  
Option PD 

This option is needed if PD measurements shall be taken from the test object. The system 
comes with a built-in measuring impedance on HV potential. The software displays all PD 
activities in a PD scope graph, allows PD pattern acquisition, and indicates the precise PD 
magnitude Qp. 

ICMflex  
Option LOC 

This option can be chosen in addition to the option PD. A special high speed sampling 
board with 16 bit 100 MS A/D converter enables the pulse measurement vs. time. This 
option is mandatory for PD fault location on cables. The software offers a special TDR 
(Time Domain Reflectrometry) graph and further evaluation tools. 

 

Fig. 2: 50 kV test set 
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III Measurement Set-up 

III.1 Verifying the Part List 

Before starting the installation it is recommended to check if all parts are available. The standard package 
consists of the following items:  

- Acquisition unit ICMflex, 
- HV filter (optional), 
- 2 battery packs; type BAT2A, 
- Battery charging device, 
- Fiber optic cable (10 m); USB to Sub-D 
- Laptop incl. software ICMflex, 
- PD calibrator CAL1B or similar incl. connection set (optional), 
- Set of cables: 

- 0.5 m HV cable (grey) with multi-contact connectors (male/female), 
- 1.0 m HV cable (grey) with multi-contact connector (male) at one end and clamp connector at 

the other end, 
- 1.5 m grounding lead (yellow/green) with multi-contact connectors (male/female), 
- 2.0 m grounding lead (yellow/green) with multi-contact connector (male) at one end and clamp 

connector at the other end, 
- Set of spare connectors; type multi-contact (male/female), 
- User manual. 

Please contact Power Diagnostix in case that something is missing or that you need spares or updates. 

III.2 High Voltage Cabling 

Please be aware that the delivered high voltage cables are non-shielded cables which may not touch any 
ground potential. The insulation of the high voltage cables supplied by Power Diagnostix can stand a maxi-
mum voltage 13.8 kV with direct contact to ground. However, the cable must be installed at a safe distance 
from any grounded objects. Surface discharge activity will incept from 3 kV in case of direct contact. Please 
check the detailed Power Diagnostix "Health and Safety Instructions and Recommendations". The minimum 
distances in open air conditions, which are to be respected in relation to the applied voltage, are specified in 
appendix 3. 

 

Fig. 3: High voltage connectors 
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III.3 Location 

As mentioned above in the general procedure prior to installation, please search for a safe location close 
the specimen to install the equipment. Ask for a scaffold, delineation, or covered area, if required, and 
prevent environmental conditions with high relative humidity and extreme temperatures. 

III.4 Parts of the ICMflex under High Voltage Potential 

The ICMflex is designed via a unique concept. The entire acquisition unit is directly placed under high volt-
age right at the position were the necessary signals are. This offers the advantage that no additional signal 
cables are needed. The filter units are constructed via the same principle. The parts that are under high 
voltage are marked with warning signs so that no confusion can happen during set-up (see images in sec-
tion III.5). 

The complete head box, including the corona cage surrounding the top of the reference capacitor and both 
MC connectors on the in- and output, is under high voltage potential. The bottom plate of the ICMflex and 
corresponding filter unit are at ground potential. 

III.5 Connecting the ICMflex 

Please read the application notes for medium and high voltage cables and rotating machines for their spe-
cific set-up overview. In general, the main connections are explained below. 

The appropriate connection of the HV source (HV transformer, resonance test set, VLF high potential) to the 
filter and/or ICMflex is mentioned on the top covers of both filtering unit and ICMflex. Please follow the con-
nection indicators accordingly. 

The HV cable of the power supply has to be connected to the female input connector of the filter (at the left-
hand side of figure 5) or, if a filter is not needed, directly to the input of the ICMflex. A bridge needs to be 
established from the male output connector of the filter (at the right-hand side of figure 5) to the female con-
nector of the ICMflex. Finally, the male connector of the ICMflex needs to be connected to the specimen. 

Fig. 4: MV cable testing on-site 

Fig. 5: ICMflex and filter connectors 
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This can be a motor terminal or the conductor of a shielded high voltage cable or a stator bar. Of course, 
the interconnection between filter and ICMflex is not necessary, if no filter is used. 

The coaxial output of the filter (left picture below) serves for the analog noise gating. A noise decoupling 
circuit is directly built into the filter to capture any noise originating from the high voltage supply itself. A 
coaxial connection between filter output and ICMflex input (right picture below) need to be established for 
the use of the gating option. Please prevent direct contact of the coax cable with the high voltage cable 
between filter and ICMflex. 

 
Very important is the ground loop of the meas-
urement setup. A bad grounding has a strong 
influence on the sensitivity due to the back-
ground noise. The main ground of the power 
supply has to be connected with the ground 
terminal of the filter unit or in case no filter is 
used, directly to the ICMflex. Connection points 
are foreseen on the metallic grounding plates. 
The connection can be made by using a cable 
lug or a multi-contact. Use the supplied short 
cables to interconnect the grounding of the filter 

and the grounding of the ICMflex and prevent any loop since this will act as an antenna and influence the 
noise behavior. Finally, a connection, which should be as short as possible, needs to established between 
the ICMflex and the main grounding of the test specimen. Please choose a solid grounding and ensure a 
good contact. The interconnection between the grounding of the filter and the ICMflex is not necessary, if no 
filter is used. 

The most convenient way to communicate with the instrument is 
via Bluetooth interface. Here, no further cabling is needed. In case, 
a Bluetooth connection cannot be established, it is possible to use 
the fiber optic serial link instead. The SUB-D female connector of 
the cable has to be connected to the male connector on the upper 
side of the ICMflex. The USB connector of the cable can be con-
nected to any free USB port at the computer. As the fiber optic 
cable provides a galvanic separation from the high voltage poten-
tial, there is no risk for the operator. 

 

Fig. 6: Coaxial gating connector for filter (left) and ICMflex (right) 

Fig. 8: SUB-D input connector 

Fig. 7: Ground connection points 
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Fig. 9: General connection diagram for ICMflex 
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IV Software & Driver Installation 

The ICMflex comes with a Windows based software package on USB stick or CD. The software can be 
installed on every windows (XP, Vista, 7, …) operating system of 32-bit or 64-bit architecture. If a computer 
is provided by Power Diagnostix, the software and the instrument drivers are preinstalled and readily con-
figured. No further action is needed to start. In all other cases some preparations must be done as ex-
plained next. 

IV.1 Installing the ICMflex Software 

Please start the setup.exe file that can be found within the ICMflex directory on CD or USB stick. If new 
software has been downloaded from the internet, it is 
mandatory to unzip all files to a local directory on the 
target system first. After starting the setup.exe file, a 
window as shown below will pop up. 

Please choose individual installation directories, if 
wanted, and click 'Next'. The installation kit automati-
cally detects earlier versions and updates only newer 
files provided by this release. This software has been 
developed under National Instruments LabWin-
dows/CVI. Therefor, additional DLLs and libraries will 
be installed automatically within the Windows system 
directory. Administrator rights are necessary to com-
plete the installation of this software product. Please 
contact your system administrator in case insufficient 

rights are given on this machine. After finalizing the 
software installation procedure the system restarts 

automatically. 

The ICMflex software can be started directly by clicking on the appropriate icon on the 
desktop. Before starting to communicate with the instrument further preparations must be 
completed as it will be explained next. 

 

Fig. 10: Software installation setup 

Fig. 11: Desktop icon 
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IV.2 Setting up a Bluetooth COM Port 

All Bluetooth devices on computer systems can provide so called virtual COM ports. These COM ports will 
be used to establish a connection with the ICMflex. Standard laptops come with built-in Bluetooth interfaces. 
If not, it is possible to use external USB-Bluetooth devices. Power Diagnostix can provide such devices for 
USB, PCI, or other connections, if needed. The Bluetooth interface on any computer provides an automatic 
scanning function. Please start this procedure to find the ICMflex Bluetooth device.  

The express mode will guide through this setup. Click 'Next'. The search routine can take a few minutes. A 
pop-up window will display all devices found in range. Select the 'ICMflex' entry and continue the installation 
procedure. 

It is mandatory to set the device code for the ICMflex connection to “0000”. 

 

Fig. 12: Bluetooth connection wizard 

Fig. 15: Entering device code Fig. 14: Bluetooth device successfully added 

Fig. 13: Adding a Bluetooth device 
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If successful, the hardware manager of Windows will automatically install virtual a COM port for the new 
device. Typically, two COM ports will be installed for the ICMflex. Enable both ports with the ICMflex software 
interface settings as described in section V.2. 

IV.3 Setting up a Fiber Optic Communication Port (USB Serial COM) 

The ICMflex comes with a special fiber optic cable. The SUB-D male connector has to be connected to the 
COM TTL female connector of the instrument box. The case of the SUB-D plug contains the hard-wire to fiber 
optic converter. The default length of this cable is 10 meters. Individual lengths can be supplied on demand. 
The side with the USB-A connector contains a fiber optic to USB converter. This end can be connected to any 
free USB port of the laptop or PC. The driver for the fiber optic cable will be installed with the software. Please 
do not connect the cable with the computer before the software is installed! If the driver is not installed 
correctly, Windows will start the Hardware Installation Wizard when connecting the USB connector the first 
time to the computer. 

To guarantee a correct installation it is recommended to perform this installation procedure while being 
connected with the internet. The Windows hardware manager searches the Windows driver library on the 
internet to find a suitable driver for this new device. Please contact Power Diagnostix in case of any problems. 

Fig. 17: Driver installation wizard 

Fig. 16: Device manager 
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If the computer does not recognize the cable, you need to install the drivers manually. Go to the device 
manager and select the related COM port. After a right mouse click you can select 'update driver'. You can 
find the driver in the following location on the computer:  
C:\pdix\Software\ICMflex\ICMflex.160\USB Driver\CP210x_v4.40. 

This procedure must be performed twice. A first time for the USB cable itself and a second time for the ca-
ble converter. 

The setup routine will automatically install the USB serial COM port, if found, and a new COM port (e. g. 
COM7) will be displayed with the device manager. 

Please note that the COM port number has to be enabled with the interface settings of the ICMflex software 
(see section V.2). After a restart of the computer the software will automatically search for the COM port in 
use. If the software can't trace the COM port, you can check manually in the device manager 

 

Fig. 18: Driver installation 

Fig. 19: Device Manager 
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V ICMflex Software 

V.1 First Steps 

The ICMflex software comes up with default factory settings after startup. All settings will be saved when clos-
ing the application. Settings affecting the acquisition circuit are sent to the ICMflex acquisition box when being 
changed. The instrument acts as slave, the software acts as master. 

Remark: If the application window appears very small when started on a PC with Windows 10, please refer 
to section XI.2 "Troubleshooting" on page 79. 

If not yet connected to an instrument the software displays all data of the last measurement. These data are 
saved with an .flx file into a specified storage directory, e. g.: 
c:\pdix\software\ICMflex\ICMflex.154\icmflex.flx 

All optional program preferences like colors, interface settings, etc. are stored in a file called: 
c:\pdix\software\ICMflex\ICMflex.154\icmflex.ini 

The main program appears as a shortcut link on the desktop, in the 'Start->Programs' folder, and can be start-
ed directly from the installation directory. 
c:\pdix\software\ICMflex\ICMflex.154\icmflex.exe 

 

Fig. 20: Main screen of the ICMflex software 
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V.2 Connecting to the Instrument 

Before connecting to the instrument it is recommended to 
check the COM port settings in the menu 'Options-> Inter-
face Settings'. Enable the port number as specified for 
Bluetooth or USB communication (see section IV.2 and 
IV.3). Normally, the software will search the instrument 
automatically when the check box 'Search Device at 
Startup' is selected. The COM port in use will be indicated 
by the * symbol. If not, the correct settings can be found 
with the device manager of Windows.  

Make sure that only one COM port is enabled. First, disa-
ble all ports by pressing the button 'Disable All'. Then 
select the COM port from the list by enabling the corre-
sponding checkmark. All other settings remain unchanged 
and do not need to be modified during standard operation. 

All changes will become active after closing this panel by 
pressing the button 'Ok'. The 'Cancel' function closes this 
window without any changes of the values. Pressing the 
button 'Standard' enables the default COM ports and sets 
all timeouts back to the following default values. 
Search Timeout: 2 s  
Run Timeout: 5 s 
Baud rate: 921600 kBit/s 

To establish a connection to an instrument press the 'Search' button on the front panel. This function can be 
started by the command button at the bottom of the window, or by selecting the 'Search' function from the 
function keys at the bottom of the window. The most important functions can also be activated by shortcuts. 
For the search routine press the function key F5. 

The search pop-up window indicates if an instrument was 
found and successfully connected. If new firmware for the ac-
quisition unit is available with the software, it is possible to flash 
the instruments program memory directly. A pop-up window 
(see figure 22) will appear and can be confirmed by the user. 
Please do not interrupt any flashing procedure and contact 
Power Diagnostix in case of any problems. Usually, the latest 
firmware will be stored into a new instrument. 

 

Fig. 21: Interface settings 

Fig. 22: Searching for ICMflex COM ports 
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V.3 Firmware Updates and Configuration Files 

After a software upgrade, it may be, that a pop-up window shows up that announces the availability of a 
new firmware version. Do not hesitate to install the update as it includes important recent improvements for 
the unit. 

Updates of firmware version >= 1.26 require a configuration file after the first launch. Normally, the latest 
ICMflex units are configured at the factory. If not or in case of older instruments, please contact the Power 
Diagnostix software department (software@pdix.com) and indicate the instrument's serial number. 

Once stored into the device, this configuration must 
not be repeated anymore in future. The configura-
tion files contains all important information of the 
instrument such as the capacitor values according 
to the voltage calibration, Cn and Csn and the shunt 
capacitor Csx high & low. These settings can always 
be cross checked via the menu 'Edit-> Advanced 
Settings” (see figure 25). 

Firmware and configuration files can be uploaded 
by using the device update function, available via 
the menu 'Tools->Device Information'. A firmware 
file is identified by the extension .bin, a configuration 
file by the extension .cfg. 
 
 

After a successful upload the communication with the instrument will shortly be interrupted and reestablished 
automatically after rebooting the acquisition box.  
 

Fig 1: Searching for ICMflex COM-port 

Fig. 26: Firmware update window 

Fig. 25: Advanced settings 

Fig. 23: New firmware pop-up Fig. 24: Configuration file pop-up 
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The device configuration panel shows detailed information about the instrument, e. g. the serial number and 
installed firmware version. To get full information connect to the instrument and open the device Information 
panel again. Since the instrument can be ordered in different configurations, check if all features are available 
as expected, e. g. 
- Partial discharge measurement 
- Partial discharge fault location for cables 
- Tan delta and loss factor measurements incl. voltage and frequency acquisition 

Besides the instrument options, the information panel also shows the battery monitoring parameters such as 
the battery voltage, current, charge, and battery lifetime. 

 

Fig. 27: Device configuration panel 
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V.4 Principle of Operation 

The ICMflex software is a typical front panel system that gives access to all main functions, graphs, and 
settings. This panel, as displayed below, is divided into four main areas. These areas can vary, depending on 
the display mode that is chosen. Available display modes are: PD, LOC, and REC. 

V.4.1 PD Display Mode 

The PD display mode mainly is for PD measurements and required calibration of the apparent charge's 
amplitude. For cable testing the cable length and pulse velocity can be calibrated in this screen as well. 

The upper left area of the window shows the voltage shapes (12-bit resolution) of the voltage dividers Usn 

Fig. 28: PD display mode 
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(reference path) and Usx (specimen path), the voltage and frequency values, and, if part of the system, the loss 
factor and capacitance values. The graph in the screen on the upper right-hand side displays continuously the 
PD activity in a 2-dimensional representation, accumulated of multiple refresh cycles vs. phase. Additionally, 
the current PD peak magnitude is shown in the upper left corner of this graph. The magnitude has to be 
calibrated (see applications notes in section V.7). The time domain graph in the lower left area can be used to 
evaluate single PD events and the reflections of pulses, as detected on medium and high voltage cable 
insulation systems on a time based curve (resolution of 100 Msamples/second). The different cursors will help 
to determine the exact fault position and to get precise results. In the area on the lower right-hand side, a 3-
dimensional PD pattern acquisition can be started and visualized. The display has a resolution of 1024 bits 
and allows further interpretation of failures within the insulation system and its cause. Besides the pattern 
itself, the related discharge levels, set time, and the number of events are shown. 
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V.4.2 LOC Display Mode 

The second display mode is called LOC mode and serves to perform PD fault location measurements on 
medium and high voltage cables. An ICMflex with option LOC for cable fault location comes with a digital 
storage oscilloscope (DSO) to process partial discharge signals on a time based curve. Single PD pulses 
can be triggered with a time resolution of 10 ns (100 Msamples/s) and a maximum display range of 320 µs 
(firmware version >= 1.25) corresponding to a theoretical maximum cable length of approximately 22 km for 
a cable with a pulse velocity of 140 m/μs. The DSO panel is the lower left graph in the software panel in PD 
and LOC mode. Besides the DSO chart, both PD representation charts remain available in upper and lower 
screens on the right-hand side. In the upper left screen the summary of the measured reflections can be 
represented versus the position of occurrence along the cable length. 

To perform cable fault location (LOC), the length of the cable and/or the pulse velocity of the cable must be 
known in advance. The time domain reflectometry (TDR) is based on the travel time of pulses. Since a cable 
behaves as a wave conductor, the TDR principle can be used to locate sources of partial discharges along the 
full cable length. 

A partial discharge pulse that is caused by an insulation imperfection travels to both ends of the cable if the 
cable has two open ends. With an open end means a cable hasn't its characteristic impedance at the end 
terminations. In this case, each partial discharge pulse occurring somewhere in the cable will be reflected to 
the opposite end, when reaching one of the cable end terminations. The distance of the PD source to the near 
and/or far end of the cable can be calculated using the time difference between the arrival times of pulses at 
the measuring impedance (coupling capacitor). 

Fig. 29: LOC display mode 
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The principle of the time domain reflectometry is illustrated with figure 30. The travel paths of the first three 
reflections of the original partial discharge pulse that enters the coupling unit of the ICMflex are displayed in 
three different colours. 

 

The reference pulse (R, black cursor) travelled di-
rectly from the pulse source to the coupling unit. 
The first reflection (1, green cursor) travelled first 
in the opposite direction of the coupler and then 
got reflected at the open end of the cable. This 
resulted in a time delay ∆t1 that indicates the dis-
tance of the PD source from the far end of the ca-
ble. Finally, the second reflection (2, blue cursor) 
shows the time delay between the reference 
pulse and its reflection at the far end. The time dif-
ference between the first and the second reflec-
tion results in a time delay ∆t2 representing the 
distance of the pulse source from the near end of 
the cable. See applications notes in section VI.1 
for a detailed example. 

 

X1= Δt1 x Vc / 2 X2= Δt2 x Vc / 2 

Fig. 30: TDR principle 

Fig. 31: ICMflex DSO screen 



ICMflex Partial Discharge & Tan Delta Measurement 
 23 

Power Diagnostix Systems GmbH ∙ Vaalser Strasse 250 ∙ D-52074 Aachen ∙ Phone +49 241 74927 ∙ Fax +49 241 79521 ∙ www.pdix.com 

V.4.3 REC Display Mode 

The third display mode is called REC mode. It is used to plot results into a summarizing table or graph. The 
collected data can be displayed vs. time or vs. voltage. The voltage graph in the upper left area remains 
unchanged. The strip chart at the upper right-hand side always shows the actual measurement readings, 
while the lower left chart shows the readings triggered in the data table of the lower chart on the right-hand 
side. Figure 32 shows the data represented versus time. By changing the setting of the X-axis to 'vs. Volt-
age', the recorded values will be shown as a function of its related voltage level. The table shows an over-
view of the voltage, tan delta and tan delta tip-up (see also section XI.1), the specimen capacitance, and the 
peak discharge level at the moment of triggering. 

The strip charts in the corner on the upper right-hand and lower left-hand side show the following values: 

- Green:  Capacitance of the sample under test (Cx) 
- Blue:  Supplied voltage level (U), represented in RMS, peak, or peak/√2 
- Black: PD magnitude in pC (Qp) 
- Red:  Loss factor value (TD) 

With each data refresh from the instrument the refreshed actual values are shown in the two upper charts. 
Recording a full measurement can be done manually or automatically by defining a measurement sequence.  

For using the manual mode, it is mandatory to start the measurement by pressing the button 'Start Rec'. To 
accumulate readings, the button 'Trigger' can be used, when reaching a required voltage step. The relevant 
data, such as the applied voltage, tan delta, tan delta tip-up value, capacitance, and apparent charge levels, 
will be registered and represented in a graph versus voltage or time in the lower left chart. 

Fig. 32: Record display mode 
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An automatic trigger mode is included and selectable by setting the record mode to 'Sequence'. The button 
'Trigger' changes to 'Sequence' and allows defining the measurement sequence. The desired voltage steps 
can be entered manually via the panel for the manual sequence or can be calculated via an automatic 
sequence after entering the specimen's ratings. 

Additional settings to be set are the voltage tolerance between the measured and the desired voltage 
levels, the number of values to be triggered at each voltage step, the time to stabilize before conducting any 
readings, and the period between consequent values at a fixed voltage step. Once a sequence is defined, it 
can be saved and loaded for consecutive measurements. 

Besides a recording with a manually defined sequence, the software also offers an automatic sequence 
mode. Here, the required voltage steps are calculated automatically according to the set specimen voltage 
represented as phase to phase or phase to ground voltage and the number voltage steps. 

Depending on the high voltage source and frequency, we recommend selecting a appropriate value for 
stabilize time and capture interval. At power frequencies a period refresh takes 16–20 milliseconds, while at 
a very low frequencies a period refresh takes more than 100 seconds. Ensure that the instrument has at 
least the chance to complete three refreshes in order to have accurate and useful data shown into the data 
table. 

 

Fig. 33: Automatic sequence wizard 
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V.5 Display Mode Settings 

Settings affecting the individual graphs or measurements can be found in the lower area of the window above 
the functional keys. Depending on the graph or area activated (indicated by a dark gray area in the 
background) different settings will be displayed. To toggle between the different setups just click once with the 
left mouse button on the area or graph that you intend to modify. 

V.5.1 Settings for Partial Discharge Measurement 

 

Setting Values / Range Explanation 

PD Auto Gain On / Off The automatic gain adjustment can help to find the best gain 
setting for the PD measurement path. If the PD signal rises 
95% of the Y-scale, the software automatically decreases the 
level. If the level drops down below 10%, the gain level will be 
incremented. 

If the PD level is bouncing strongly, it could make sense to 
disable the automatic mode. 

PD Gain 1,2,4,8,10,20,40,80,
100,200,400,800,10
24,2048,4096 

The signal amplification can be set manually by selecting an 
adequate factor from the list. An optimal PD level is given, if the 
highest peaks appear in a range of 60 to 90% of full scale. 

Cal Gain 1,2,4,8,10,20,40,80,
100,200,400,800,10
24,2048,4096 

This entry indicates the gain value as it was set during 
calibration. This value will be modified automatically during 
calibration and cannot be set manually. 

Cal Value 1pC–10000pC This value has to be set according to the PD level that is used 
during calibration. 

Highpass 40 kHz, 80 kHz, 
100 kHz 

Depends on the lower cutoff frequency of the PD bandpass 
filter. 

Fig. 34: Chart settings 

Select relevant chart

Related settings become available
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Lowpass 250 kHz, 600 kHz, 
800 kHz 

Depends on the upper cutoff frequency of the PD bandpass 
filter. 

LLD 0–100% LLD stands for Low Level Discriminator. This is the minimum 
trigger level for PD pulse acquisition. A minimum level of 2% 
should be set to eliminate small noise pulses. The level refers 
to the 100% full scale of the Y-axis of the PD scope and PD 
pattern graphs. 

Coding Unipolar / Bipolar PD pulses can be separated by their polarity. 'Bipolar' shows 
positive and negative pulses separated, whereas 'Unipolar' 
does not consider the polarity. 

Gating On / Off If gating is enabled (On) it is possible to eliminate external 
noise pulses. This function is available with all instruments 
offering an external 'Gate In' connector on the acquisition box. 
The noise signal is taken directly on the HV line input on the HV 
filter. A special high frequency current transformer has to be 
built-in. 

Gate Level 0–100% This trigger level determines the sensitivity on the gate input of 
the acquisition system. As higher this level is set as less 
external pulses will be triggered. 

Sync Mode Normal, 
VLF 0.1 Hz, 
VLF 0.05 Hz, 
VLF 0.02 Hz 

Normal: The frequency of the applied voltage is calculated 
automatically in a range between 20 Hz and 510 Hz. 

VLF: The frequency is set manually according to the 
frequency setting on the VLF power supply. 

Set Time 0..100000 s Preset set time for a PD pattern acquisition. The pattern (map) 
is stopped automatically after expiration of this time. 

V.5.2 Settings for PD Fault Location 

 

Setting Values / Range Explanation 

DSO Auto Gain On / Off The automatic gain adjustment can help to find the best gain 
setting for the LOC or DSO graph. If the PD signal rises 95% of 
the Y-scale, the software automatically decreases the level. If 
the level drops down below 10%, the gain level will be 
incremented. An automatic voltage adjustment is 
recommended for the normal sync mode only. 

DSO Gain 1,2,4,8,10,20,40,80,
100,200,400,800 

Amplification factor for the PD signal in time domain. 

Trg. level 0–100% Trigger level for high resolution PD pulses in the time domain 
graph. 

Trg. Mode Auto 
Normal 
Single Shot 

Auto:  This mode displays continuously a signal on the 
DSO graph (triggered or non-triggered signals). 

Normal:  This mode displays continuously triggered signals 
only. 

Single Shot:  This mode displays a single triggered PD event 
and stops the refresh subsequently. 
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Pre Trigger 1–10 µs Time on the DSO graph from zero position to the first trigger. 

Scan time 2–320 µs Total measurement time for PD signals versus time (DSO 
graph). 

Zoom 2–320 µs Zoomed area within the DSO graph. Zooming allows a more 
precise positioning of the cursors.  

Zoom Pos 2–320 µs Zero position of the zoomed area.  

Cable Len. 10–25000 m Length of the cable under test. This length can be calculated 
during calibration or can be preset if the exact value is known. 

vc [m/µs] 

vc/2 [m/µs] 

100–200 m/µs 

50–100 m/µs 

Pulse velocity for PD signals on the MV cable. 

V.5.3 Settings for the Record Mode 

 

Setting Values / Range Explanation 

U Auto Gain On / Off The automatic gain adjustment can help to find the best gain 
setting for the voltage measurement path. If the voltage signal 
rises 95% of the Y-scale, the software automatically decreases 
the level. If the level drops down below 10%, the gain level will 
be incremented. An automatic voltage adjustment is 
recommended for the normal sync mode only. 

Gain Usn 1,2,3,4,5,6,7,8,9,10,
11,12,13,14,15,16 

Amplification factor for the voltage signal from the shunt 
capacitor on the reference path; Umax = 20 Vpeak 

Gain Usx 1,2,3,4,5,6,7,8,9,10,
11,12,13,14,15,16 

Amplification factor for the voltage signal from the shunt 
capacitor on the test pat;. Umax = 200 Vpeak 

Cn Stored into device 
via configuration file 
firmware version 
>= 1.26 

Capacitance value of the reference capacitor. Please check the 
data sheet of your system or read the value as written on the 
gray acquisition box. 

Csn Stored into device 
via configuration file 
firmware version 
>= 1.26 

Capacitance value of the shunt capacitor of the reference path. 
Please check the data sheet of your system or read the value 
as written on the gray acquisition box. 

Csx (see remark 
below) 

No limit; to be 
calculated before 
high voltage is 
applied 

Capacitance value of the shunt capacitor of the test path. 
Please check the data sheet of your system or read the value 
as written on the gray acquisition box. With most systems this 
value is switchable (ext. jumper) between two ranges, e. g. 
40 µF/400 µF 

Scaling Auto / Full Range Y-axis scaling mode for the voltage graph (left upper corner). 
The voltage shape is scaled up to a maximum in 'Auto' mode, 
the 'Full Range' mode sets the maximum of the Y-axis to the 
maximum value according the gain chosen. 
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Record Mode Manual / Sequence This mode is important for the record function. In 'Manual' 
mode the values in the record table are filled with each manual 
trigger event. The Sequence mode fills data into the table if a 
preset voltage level is reached. These voltage levels must be 
predefined in advance. 

X-Axis vs. Time / vs. Voltage The record graph in the left lower corner can show the recorded 
values versus time or versus voltage. 

Sync Mode Normal, 
VLF 0.1 Hz, 
VLF 0.05 Hz, 
VLF 0.02 Hz 

Normal: The frequency of the applied voltage is calculated 
automatically in a range between 20 Hz and 510 Hz. 

VLF: The frequency is set manually according to the 
frequency setting on the VLF power supply 

Remark: 

The setting of the shunt capacitance value for the test circuit Csx depends on the maximum voltage under 
test. The highest voltage at the shunt capacitor Csx must not exceed 200 Vpeak or 140 Vrms. 

Ux (max)= Umax · Cx,(max) / Csx < 140 V   (!) 

Please select the values for Csx according to the test specimen capacitance and the required maximum test 
voltage (Umax). The shunt capacitor values are stored into the device settings via the configuration file pro-
vided by Power Diagnostix. The actual values of voltage levels given by both dividers Un and Ux can be 
represented in the voltage display via selecting Uacq. Wrong selection of the shunt capacitor will result into 
clipping of the sine wave. Please be aware that Un,max may not exceed 20 Vpeak (14 Vrms) and Ux,max may not 
exceed 200 Vpeak (140 Vrms). 

 

 

Fig. 35: Voltage measurement chart 
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V.6 Functions and Menus 

The ICMflex software offers multiple functions directly from the front panel or via the menu bar on top. 
These functions can vary, depending on the display mode chosen, or depending on the hardware options 
available with the instrument. 

V.6.1 Menu Items 

V.6.1.1 File 

Standard file functions, such as loading and saving of files and setting the default directory, can be selected 
directly from the 'File' menu. Further, waveform and/or record exports to an .xls, .xlsx or .html file can be 
selected here as well. After loading the .flx file from hard disc the export will be made automatically. 

 

 

 

V.6.1.2 Edit 

The 'Edit' menu contains the options for copying the active graph into the Windows clipboard. Furthermore, 
it offers access to advanced settings for the device (see figure 37), to report functions, and to options for 
cable accessories (see figure 38). 

If the cable is equipped with accessories at a fixed 
position that is known, such as joints, terminations, and 
cross link boxes, for instance, these can be shown as a 
symbol in the summarizing LOC graph. The exact position 
along the cable length and the desired symbol and color 
can be set in the 'Cable Acessories' option. 

 

Fig. 36: File menu 

Fig. 38: Cable accessory window 

Fig. 37: Edit menu 
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The software can generate a standard report as 
explained in section V.6.2.1 and/or a detailed 
cable measurement report. In general, the rep-
resented measured data are comparable. The 
differences are mainly the various details con-
cerning the specimen under test, which can be 
entered, and the cable accessories for known 
positions along the cable length. 

 

 

 

 

 

 

V.6.1.3 Connect 

A connection of the software to the ICMflex can be establish via the function key F6 or by pressing the 
'Search' button in the key bar. 

V.6.1.4 Options 

The 'Options' menu largely offers settings for the various charts. Besides this, the language, display resolu-
tion, and the interface settings, as explained in section V.1, can be selected 

V.6.1.5 Tools 

With the 'Tools' menu the device information can be seen as shown with figure 27. 

 

Fig. 39: Cable measurement report window 

Fig. 40: Connect menu 

Fig. 41: Options menu 

Fig. 42: Tools menu 
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V.6.1.6 Help 

The 'About' item of the 'Help' menu gives information about the installed software release. In case of any 
further questions regarding the device Power Diagnostix's contact details are given as well. 

V.6.2 Function Keys 

All main functions are shown on the bottom of the window. Some buttons cover multiple functions depend-
ing on the display mode of the software. 

V.6.2.1 Report [F1] 

Pressing this button will open a pop-up window. Here, it is possible to fill out a standard report with brief 
information regarding the measurements taken. This set of information will be saved with each ICMflex file 
(*.flx) and will be available after loading files from hard disc. It will appear on most printouts and with all 
exported data, like .html or .xls(x) files. The required live charts for the report can be selected with the cor-

Fig. 43: Help menu 

Fig. 44: 'About' window 

Fig. 45: Standard report 
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responding checkmarks at the bottom of the panel. Please be aware that the charts taken into the report are 
always the current charts. 

V.6.2.2 Calibrate [F2]: 

The 'Calibrate' function can be used to calibrate either the PD amplitude or the cable length of an MV cable 
under test. To calibrate the PD amplitude it is necessary to activate the PD scope display (graph on the 
upper right-hand side) or the PD pattern display (graph on the lower right-hand side). Pressing this button in 
this mode will open a pop-up window where the exact PD calibration value has to be filled in. This value is 
equal to the value displayed on the PD calibrator (CAL1A or CAL1B). Please check the correct connection 
of the PD calibrator, the correct gain setting, and the PD pulse on the PD scope display before calibrating. 
Further explanations are given with the applications notes in sections VI.1.2 and VI.2.2. The length of an 
MV cable can be calibrated by activating the DSO display first (lower left graph). Check the reflections of PD 
pulses on the graph and set cursor R and cursor 2 to the first and the second pulse. After pressing the but-
ton 'Calibrate' the software automatically calculates the pulse velocity of the PD pulses. Further explana-
tions are given with the application notes in section V.8. 

V.6.2.3 Copy [F3]: 

This helpful tool allows copying each graph to the Windows clipboard. Pressing this button will place a copy 
of the activated graph (panel with dark gray background) into the clipboard, which can be pasted afterwards 
into all documents of other applications. 

V.6.2.4 Load [F4]: 

This function is available when being offline, means not connected to an instrument. It allows loading old 
measurements from hard disc or any other memory. Files saved with the ICMflex software come with the 
file suffix *.flx. This file consists of all measurement data, settings, and reports. To restore typical settings it 
is helpful to save some default files for standard set-ups for cables or rotating machines. 

V.6.2.5 Save [F5]: 

It is possible to save the *.flx files in all different modes. Old files can be loaded, modified, and saved again. 
Running measurements can be saved at any time. The saved file consists of all measurement data, set-
tings, and reports. 

V.6.2.6 Search / Offline [F6]: 

To connect the ICMflex software with an instrument, press the 'Search' button. If the COM port settings and 
the cabling are correct and the instrument is turned on, a pop-up window will show the message 'ICMflex 
found at COM xy'. It will disappear automatically after a few seconds. To disconnect the communication 
line, press the same button once again. While being online this button is labeled 'Offline', while being offline 
this button is labeled with 'Search'. 

V.6.2.7 Start Rec / Stop Rec [F7]: 

This function can be used to start a record of values vs. time. Switch to the TD display mode to see all val-
ues recorded in the corresponding graph and in the table. This function has to be started manually and can 
be stopped by pressing the same button. 

V.6.2.8 Start Map / Stop Map [F8]: 

Use this function to start a PD pattern acquisition. The pattern is shown in the graph on the lower right-hand 
side. The measurement is stopped automatically after expiration of the preset 'Set Time' or after pressing 
this button once again. 

V.6.2.9 Print [F9]: 

This function sends the active graph to the default printer. 

V.6.2.10 Exit 

Close the program by pressing this button.  
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V.7 ICMflex and PD Calibration 

V.7.1 Calibrators 

There is a broad range of impulse generators offered by Power Diagnostix for different purposes. The table 
below gives an overview of these calibrators. All of them allow the calibration of PD measurements according 
to IEC 60270/2000, except the CAL2B/C/D. Since these calibrator models are not equipped with an injection 
capacitor to enable calibration on GIS. For the ICMflex's applications, the most common calibrators used are 
the CAL1B for on-site testing and CAL1A for laboratory purposes. 

Calibrator Range Output Frequency 

CAL1A 1, 2, 5, 10, 20, 50, 100 pC Injection capacitor <1 pF 50 Hz (60 Hz) 

CAL1B 100, 200, 500pC, 1, 2, 5, 10 nC Injection capacitor <100 pF 50 Hz (60 Hz) 

CAL1C 1, 2, 5, 10, 20, 50, 100pC* at 100 pF Voltage output (50 Ω) 50 Hz (60 Hz) 

CAL1D 10, 20, 50, 100, 200, 500, 1000 pC Injection capacitor <10 pF 50 Hz (60 Hz) 

CAL1E 0.5, 1, 2, 5, 10, 20, 50 nC Injection capacitor <500 pF 50 Hz (60 Hz) 

CAL1F 0.2, 0.5, 1, 2, 5, 10, 20 nC Injection capacitor <200 pF 50 Hz (60 Hz) 

CAL1G 0.02, 0.05, 0.1, 0.2, 0.5, 1, 2 nC Injection capacitor <20 pF 50 Hz (60 Hz) 

CAL1H 0.5, 1, 2, 5, 10, 20, 50pC* at **pF Voltage output (50 Ω) 50 Hz (60 Hz) 

CAL1J 
10, 20, 50, 100, 200, 500, 1000pC* at 100 pF 

100, 200, 500, 1000, 2000, 5000, 10000pC* at 1 nF 
Voltage output (50 Ω) 50 Hz (60 Hz) 

CAL2A 0.5, 1, 2, 5, 10, 20, 50 pC Injection capacitor <1 pF 50 Hz (60 Hz) 

CAL2B 2, 5, 10, 20, 30, 40, 50 V (into RL=50 Ω) Voltage output (50 Ω) 50 Hz (60 Hz) 

CAL2C 1, 2, 5, 7, 10, 12, 15, 17, 20 V (into RL=50 Ω) Voltage output (50 Ω) 50 Hz (60 Hz) 

CAL2D 5, 7.5, 10, 15, 20, 30, 40 V(into RL=50 Ω) Voltage output (50 Ω) 50 Hz (60 Hz) 
*with external high voltage capacitor, ** value to be specified by customer 

Table 1: Calibrator overview 

All calibrators are switched on with the pushbutton On/Off. Both amplitude (Range) 
and polarity (Pos/Neg) of the single charge pulse per cycle are displayed and can be 
adjusted by pressing the two buttons. The instrument is synchronized to line fre-
quency by a photo diode. In case of insufficient pick-up of power frequency light, it 
will select automatically the internal quartz oscillator (50 Hz and 60 Hz versions 
available). The button On/Off must be pressed for more than one second to switch 
the pulse generator off, while automatic switch-off occurs after approximately 15 min. 
Operation time of up to 200 hours are obtainable with the 9 V lithium battery due to 
an average supply current of approx. 5 mA (quiescent current is negligible). An alka-
line battery resulting in approx. 90 hours of continuous operation may replace the 
lithium battery. A weak battery is indicated by the LO BAT sign of the LC display. 

Warning: While changing the battery, be aware of internal parts carrying up to 125 V 
of DC potential! 

Fig. 46: CAL1A 
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Power Diagnostix delivers its standard calibrators with a fully traceable DAkkS calibration 
(D-K-15068-01-00). This calibration certificate documents the traceability according to national standards, 
which fulfill the units of measurement according to the International System of Units (SI). The DAkkS 
(Deutsche Akkreditierungsstelle) is signatory to the multilateral agreement of the European co-operation for 
Accreditation (EA) for the mutual recognition of calibration certificates. 

Before attaching the calibrator please make sure that the object under test is de-energized. The inner con-
ductor of the BNC/Banana adapter must be terminated to the test specimen’s conductor. The outer ground 
connector has to be connected with the solid grounding of the test object. Ensure ground links between the 
calibrator and the ground shield that are as short as possible. Care must be taken, that the calibrator is 
isolated from the HV part of the ICMflex. 

The selection of the relevant charge level to be injected into the measurement circuit can vary, depending 
on the cable length, stator winding's or bar's capacitance (attenuation), and background noise conditions. 
It’s important to have a good signal to noise ratio in order to have a sufficient sensitivity. Chose a value 
approx. 5 to 10 times higher than the present background noise. Typical values used for on-site testing are 
varying from 200 pC to 5 nC, even 10 nC in case of very long cable lengths or large turbo generators. 

Once the injected value is selected, the calibration pulse can be observed in the ICMflex software. The rele-
vant screens supporting the calibration of the apparent charge are the two charts on the right-hand side of 
the PD display mode. The upper chart represents the calibration pulse as scope like pulse pattern (2-
dimensional) while the lower one plots the pulse into an Φ-q-n related pattern (3-dimensional). Please ad-
just PD gain in a way the calibration pulse fills 60–90% of the maximum current amplitude. Also select the 
proper SYNC setting during calibration, CAL50Hz or CAL60Hz, even if VLF is used. Using the same set-
tings also for VLF, only speeds up the screen refresh. Select the value for the low level discriminator high or 
low enough, so that the background noise can still be observed. Don't forget to switch off the gating function 
during calibration. 

Calibration can be performed by a double click on the highest pulse 
shown in the scope like display or by a double click on the corresponding 
upper line in the phase resolved PD pattern. Thereafter, the calibration 
pop-up will ask for the value of calibration charge. Once entered, the 
compensation of the attenuation of the complete circuit will be done au-
tomatically. Please have in mind that the calibration is valid for one band-
bandwidth and one specific test set-up only. Hardware and/or software 
changes require a new calibration. Don't forget to save the calibration 
file.  

Please ensure that the selected unit [pC/nC] and amplitude fit with the 
injected charge. For further information about calibration, please check 
sections VI.1.2 and VI.2.2. 

Fig. 49: Calibration charge pop-up 

• Always provide solid grounding of the instrument and the filter units. 

• Make sure that the cable/machine is de-energized before calibration. ! Warning: 

Fig. 47: Calibration pulse scope display 

Calibration pulse 

Noise level 

Fig. 48: Calibration pulse PD pattern 
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V.8 Gating 

V.8.1 Principle of Operation 

Caution: The analog gating input of the ICMflex is solely for connecting to an HV filter! Never connect an-
other instrument to this input, because this will result in serious damage of the equipment  

When using the gating function in the ICMflex, disturbance signals coming over the HV-line are captured by 
the HFCT that is embedded into the high voltage filter (T50/05 or equivalent). The output of the HFCT 
should be connected the GATE IN BNC terminal of the ICMflex or ICMflex GRC. Internally in the instrument, 
a built in preamplifier takes care of the signal conditioning. The bandwidth for the gating signal is internally 
set from 2 to 20 MHz. Analog gating can be activated in the software in the PD Mode (gating on) and the 
gating threshold in % (gating sensitivity) must be set according to the level of the measured disturbance 
pulses. The gate level in percent is referring to the maximum scale of the PD pattern or PD scope view at 
the particular gain. In order to adjust the gate level to blind out the switching pulses of the VLF for instance, 
the general background noise must be investigated; the LLD level shall be set to the top of the overall am-
bient noise. As soon the LLD level (top of the ambient noise) is known, the gate level can be selected at a 
level above the LLD level in order to prevent excessive gating times. As soon the instrument is effectively 
gating, the corresponding gating time is shown in the PD scope graph (right upper one in the PD mode). 
The gate time in percent is referring to the time the instrument is gating during one full cycle. 

Example: 
With 0.1 Hz, one cycle is 10 s, if the gate time is 30%, gating has been active for 3 s. 

Fig. 51: PD and VLF switching pulses Fig. 52: Switching pulses effectively gated 

Fig. 50: Gating Inputs 

Analog 
GATE IN 

only! 

Fiber optic 
GATE IN 
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In the example mentioned above the LLD level was 5%, the gating threshold was set to 8% causing a gat-
ing time of 7%, i. e. 0.7 s with a sine wave of respectively 0.1 Hz. 

Try to reduce the gate time below 30% in order not to lose significant PD pulses. Hence, don't set the gating 
sensitivity too low, so that the corresponding gate time is exceeding 30 to 50%. Any remaining ambient 
noise beside the switching pulses of the VLF, transformer, or RTS are not blocked using analog gating. For 
such sort of disturbances fiber optic gating using the GST1 and a CT is available. 

V.8.2 Gating via Fiber Optic Link (FO Gating) 

An ICMflex with a gating function comes with an additional terminal for a fiber optic (FO) cable, which takes 
over a signal on HV potential provided by a gating signal transmitter (GST1). The transmitter is included in 
the delivery range if FO gating is ordered. An external signal sensor (e. g. CT1) is connected via a BNC 
cable to the 'GATE IN' terminal of the GST1. 

If disturbances like switching of a relay or thyristor firing have a known source, it might be possible to create 
a TTL signal prior to the disturbance. This signal can be used to blind out the PD measurement path. If a 
TTL signal is available, it can be provided to the GST1 via a BNC cable that is connected to the ''TTL IN' 
terminal. 

Caution: Never connect the GST1's BNC TTL output         to the analog gating input of the ICMflex. This will 
result in serious damage of the instruments! 
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Fig. 53: Gating connection diagram 
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The gating signal transmitter GST1 has a logarithmic amplification and can be set to three different frequen-
cy ranges (40–800 kHz, 2–20 MHz, or 200–600 MHz), which can be selected with a push button. The active 
bandwidth mode is marked by a lit green LED. The gate level can be adjusted with the rotary switch of the 
GST1 and is indicated by the orange LED. The level of the analog signal incoming via 'GATE IN' is indicat-
ed by the green LED bar. If it exceeds the selected gate level, the bar changes to red. The gate level should 
be set to the maximum when using a TTL gating signal as signal source, only. 

 

 

 

OR

TTL Gate Out
(FO cable)Gate level Peak

detection Peak > Gate level
Analog Gate In
(RG58 cable)

TTL Gate In
(RG58 cable)

GST1

TTL Gate Out
(RG58 cable)

Input for analog gating signal

Input for TTL gating signal

Output for gating signal to ICMflex
(FO TTL GATE OUT)

Output for TTL gating signal
(e. g. to ICMsystem or ICMcompact)

9V power supply

Push button for bandwidth selection 
and for switching on/off 
Rotary switch for gate level adjustment 

LED scale, that indicates the level of 
the incoming analog gating signal and 
the selected gate level 

Fig. 54: Gating signal transmitter (GST1) 

Fig. 55: Disjunction of gating signals when simultaneously using analog and TTL gating 
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VI Application Notes 

The application notes for medium and high voltage cables, rotating machines, and single stator bars, de-
scribe the specific measurement set-up, calibration, step by step procedure for performing the measure-
ment, software usage, and evaluation criteria according to the relevant standards. 

VI.1 Medium and High Voltage Cables 

VI.1.1 Measurement Set-up 

A general description of the measurement set-up is given with section III. In this case, the focus lies on the 
medium and HV voltage cable application. Most important is the interconnection between the main ground-
ing of the high voltage supply and the cable ground shield. The final link from the grounded baseplate of the 
ICMflex to the ground shield must be as short as possible. The high voltage output cable of the ICMflex has 
to be connected to the inner conductor or termination. The order of connecting the various links is shown in 
figure 56. 

VI.1.2 Calibration 

Performing high voltage tests including partial discharge measurements and PD fault location on cables 
requires calibration of both the apparent charge and the cable length. When the safety procedure as men-
tioned in section I.3 is accomplished and when the set-up is built-up as described above, the calibration can 
be performed. General procedures are described in the Power Diagnostix's user manual for calibration im-
pulse generators. However, the detailed calibration procedure for cable fault location is explained below. 

Since a test specimen has a capacitance against the ground shield, for medium and high voltage cables 
varying from 200 pF/m to 425 pF/m, the cable capacitance will cause strong attenuation of the injected 
pulse. The difference between the injected and measured Qp level is the k-factor, the overall attenuation 
factor of the complete test circuit. The k factor has to be compensated by the calibration. 

(2) (3) 

(5) (6) 

(2) 

(3) 

(5) 

(6) 

(1) 

(4) 

Fig. 56: MV cable measurement set-up 
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Common calibration levels for laboratory acceptance tests are in range of 2 to10 pC (CAL1A). However, for 
on-site testing the set-up sensitivity often does not allow such a sensitive calibration as in the laboratory. 
Due to this, calibrations are often made with injection levels from 100 pC to 2 nC (CAL1B). 

Except the calibration of the apparent charge in accordance with IEC 60270 the cable length or pulse veloc-
ity has to be calibrated for performing PD fault location (TDR). At least one of the two values must be known 
in advance. Table 2 lists some typical values for the velocity of propagation in relation to the cable insulation 
type. Please note that these values can vary, depending on the nominal voltage and dielectric strength. 
Usually, the cable supplier provides the exact values with the cable data. 

Insulation Type Vc (m/µs) Vc/2 (m/µs) 

XLPE 147–168 73–84 

PILC 147 73 

EPR 165 82 

Vacuum 300 150 

Table 2: Pulse velocity factors 

The injection principle is the same as with the calibration of the apparent charge. Maybe a higher charge 
level is required to see the necessary reflections for the TDR. Often a pulse magnitude of 5 or even 10 nC is 
required. If the injected calibration pulse is not visible in the DSO screen, it's necessary to increase the val-
ue of 'DSO Gain', until the pulse becomes visible. It's also important to choose a trigger value that is high 
enough. Do not trigger on disturbance levels. Besides the DSO gain and trigger level, ensure that the reflec-
tions are visible by adjusting the time base (X-axis). 

For the calibration of the cable length, the cable terminations must be opened on both sides so that they 
have infinite impedance. Please check the cable set-up carefully before calibrating. 

 

Fig. 58: CAL1B connected to MV cable (on-site) Fig. 57: CAL1B connected to MV cable (lab) 



ICMflex Partial Discharge & Tan Delta Measurement 
 41 

Power Diagnostix Systems GmbH ∙ Vaalser Strasse 250 ∙ D-52074 Aachen ∙ Phone +49 241 74927 ∙ Fax +49 241 79521 ∙ www.pdix.com 

The DSO screen on the right-hand side shows the first two reflections arriving at the measuring 
impendance. Since the cable has an open end, we know that the time difference between the reference 
pulse and its first reflection represents twice the cable length. The factor of 2 is automatically computed and 
must not be considered. The DSO screen on the left-hand side shows the result of a shorted cable. Here, 
the second reflection shows a polarity change due to the negative reflection factor. Please check both ends 
in such a case. 

For the calibration of the cable length its important to consider the following parameters: 

• DSO gain : The reference pulse must fill 60–90% of the max. actual scale 

• Trigger level : Must be selected sufficiently high not to trigger on disturbance pulses 

• Scan time : To be set according to the cable length for having the best sensitivity (0–320 µs) 

• Zoom : Use the zoom function to position the cursors more accurate 

• Zoom position : The start position of the zoom function with reference to the X-axis 

The black cursor (R) must be placed at 
the beginning of the reference pulse; 
the blue cursor (2) must be placed at 
the beginning of the first reflection. If 
the cable length is given, the 'Calibrate' 
button at the bottom of the window can 
be pressed. The software will ask to 
edit the cable length accordingly. In 
case the pulse velocity is given, this 
value must be entered in for Vc. When 
the pulse velocity is known and both 
cursors are set correctly, X2 will show 
the cable length. The more accurate 
the cursor positions are, the more ac-
curate the distances will be calculated. 
We recommend saving the file. 

 

Fig. 61: Cable length calibration 

Fig. 59: Cable with shorted end Fig. 60: Cable with open end 
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VI.1.3 Standard PD Measurement 

Once the calibration procedure is completed and the calibrator has been removed from the test specimen, 
the voltage may be switched on. Please pay attention to the correct settings of the shunt capacitor Csx (low 
or high) as mentioned in section V.5.3. 

Before switching on the voltage, it’s important to observe the present background noise level. Adjust the PD 
gain and LLD level so that the maximum of the background noise is still visible. Do not set the LLD level 
completely to 0% in order to prevent occupying the A/D converter with converting background noise pulses. 
Masking the background noise up to 80% of its maximum amplitude is an acceptable level. 

After switching on the voltage, maybe additional noise cancellation is required to get rid of disturbances 
caused by the power supply itself or by external sources. This can be done by using the gating option, ei-
ther with analog gating or gating via a fiber optic gating transmitter. Please consult section V.8 for more 
information. 

The next step is finding the partial discharge inception voltage level. It stands to reason that before reaching 
the partial discharge inception voltage (PDIV), no root cause analysis or PD location investigation using 
time domain reflectometry can be performed. According to IEEE 400-3, for instance, a healthy cable will not 
show any sign of partial discharge activity before reaching a voltage level lower than 2 Un. 

Once the inception voltage is reached, the PD pattern can be mapped and compared with typical phase 
resolved pattern from known PD origins (see section VI.1.7). Besides the pattern, the related discharge 
levels (Qp, QIEC) and the average discharge current (NQS) are given. Please pay attention to the correct 
settings of PD gain and LLD level. Choose a gain value in such a way, that the PD pulse amplitude is be-
tween 50–90% of the maximum scale. The first line analysis concerning the nature cause or PD origin can 
be made using the pattern. The location along the cable length must be traced via time domain reflectome-
try. Typical times for mapping the phase resolved pattern are 30 to 60 seconds for power frequency and 
about 500 to 1000 seconds for VLF at 0.1 Hz. 

Fig. 62: Surface discharge (PD pattern) Fig. 63: Surface discharge (scope mode) 
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VI.1.4 PD Measurements on Cables with High Capacitance 

For PD measurements on specimen with high capacitances Power Diagnostix 
provides the extension box CSX900 that extends the Csx value of the ICMflex 
to 900 µF. The box is mounted onto an isolator of predefined height according 
to the maximum voltage level of the VLF source. 

The following figure shows the set-up when using the CSX900 box. 

 

Fig. 65: Measurement set-up with extension box CSX900 for specimen with high capacitances 

Fig. 64: Extension box CSX900 

Capacitance range 
jumper plugged in 
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VI.1.5 PD Fault Location 

When the PD pattern is mapped and saved and required notes are made; focus should be laid on the digital 
storage oscilloscope. Here, each partial discharge pulse is represented on a time based curve. First of all, 
the settings must be modified so that the reference pulse and the two first reflections arriving at the coupling 
unit are visible in the screen as explained in section V.4.2. 

Once the partial discharge activity has initiated, the digital storage oscilloscope can be used for estimating 
the PD location. To find the PD location, some good TDR shots must be taken. Accurate DSO settings be-
fore starting the scan procedure will result in shorter measuring and analysis time. Moreover, fewer scan 
files are required to find the PD location. 

When the DSO settings (such as the DSO gain, trigger level, scan time, zoom, and zoom position) are op-
timized so that the reference pulse and the first as well as the second reflection are clearly visible in the 
DSO screen, the scan procedure may be started. While scanning, snapshots will be taken from pulses ex-
ceeding the trigger level. It’s important to select a reasonable trigger level that prevents triggering on dis-
turbance signals. After pressing of the 'Scan' button in the DSO menu, the pop-up screen for scan settings 
will appear. 

• Select the required data directory for saving of scan files 

• Enter the maximum number of scan files (up to 1000) 

• Phase selection (1, 2, or 3) 

• Name of phase under test 

• Enter the file prefix, useful for later analysis 

• If non-triggered snapshots are also needed, select the corre-
sponding option 

• To start the scan, press 'OK' 

 

After the scan procedure is finished, the PD location can be 
pinpointed. Therefore, you have to go offline with the software 
and run the 'Start Replay' function from the function keys at 
the bottom of the window. Here, you can evaluate the scan 
files manually. First, the software requests you to select the 
folder were the scan files are stored. 

Once you have chosen the relevant folder, you can select the 
.tdr files to be evaluated. By selecting the files and pressing 
the 'Add' button, the selection of .tdr files will be shown in the 
selection box (see figure 67). To confirm the selected files, 
simply click 'OK'. The software will automatically open the 
replay function. 

 

 

 

Fig. 66: Scan settings pop-up 

Fig. 67: Scan files selection 
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The main task of the replay function is the correct posi-
tioning of the cursor for the reference pulse (grey cur-
sor) and the cursor for the first reflection arriving at the 
coupling capacitor (green cursor). The file name of the 
current .tdr file is displayed above the diagram. 

Below the diagram are text fields indicating the dis-
tance between the cursors, the time delay between the 
two pulses, the voltage level at which the files were 
recorded, and the related Qp level for the file. 

 

 
 
 
 
 
 
 

In the bottom part of the replay screen, you can choose between the following buttons: 

• Cancel: For stopping the current replay 

• Save File As: For storing the current file 

• Delete File: For removing the file from the selection 

• Back: For returning to the previous file 

• Skip: For switching to the next file 

• Select All: For adding all files into the LOC screen 

• Select: For adding the current file into the LOC screen 

After having positioned the cursors for the reference pulse and first reflection, you can press 'Select' to add 
the related position of the PD activity along the cable in the summarizing LOC diagram. When scan files are 
validated and resulting in the identical position along the cable, the result of each single event will be added 
and shown as the total amplitude in the red bar. The PD amplitude refers to the peak discharge level at the 
time of scanning and does not indicate the PD amplitude at the position of occurrence. 

With the check box 'Loc Grid' it's possible to switch 
on grid lines within the LOC chart. With the option 
'Projections' you can enable cursors in the LOC 
chart. The mapping reference, i. e. near or far end, 
is indicated by the coupler symbol on the X-axis. 
Depending on the precision of the settings during 
the scan, you may require fewer scan files for find-
ing the PD fault location and thereby shorten the 
evaluation time during replay. 
 
 
 
 

Fig. 68: Replay screen 

Fig. 69: LOC chart 
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VI.1.6 Test Voltage Recommendations and Criteria 

According to the relevant standards for medium and high voltage cable testing, test voltages, sequences, 
and PD evaluation criteria are described in relation to the cable's voltage class. Please select the test type 
to be performed i. e. acceptance testing or on-site testing. On-site testing is mostly performed after installa-
tion tests. Such testing is recommended in order to verify the performance of the cable accessories such as 
joints and end terminations, which are often mounted on-site. Table 3 describes the recommendations given 
by the relevant IEC standards. 

 Acceptance Testing On-site Testing 

Standard Frequency Voltage PD Criteria Frequency Voltage  PD Criteria 

1 kV < U < 40 kV 

IEC 60502 49–61 Hz 3.5 U0/5 min 1.73 U0 < 10 pC 49–61 Hz 
49–61 Hz 
DC 

1.73 U0/5 min 
U0/24h 
4 U0/15 min 

None 

40 kV < U < 150 kV 

IEC 60840 49–61 Hz 2.5 U0/30 min No PD 
up to 1.5 U0 

20–300 Hz 
49–61 Hz 

1.73–2 U0/1 h 
U0/24 h 

None 

150 kV < U < 500 kV 

IEC 62067 49–61 Hz 2.5 U0/30 min 
2.5 U0/60 min 

1.5 U0 < 10 pC 20–300 Hz 
49–61 Hz 

1.1–1.73 U0/1 h 
U0/24 h 

None 

Table 3: MV cable test voltages 

As you can see, no PD criteria are given for on-site testing. Shielded test room conditions cannot be com-
pared with on-site conditions. The main reason is the set-up sensitivity which is often critical because of the 
background noise. In shielded test rooms background noise levels from less than 2 pC can be obtained and 
for those cases, specifying criteria makes sense. With on-site testing a background noise from few tens up 
to hundred pC is not unusual. In this case, it’s important to build up a well-considered partial discharge free 
test set-up and to perform sufficient sensitivity checks at all available positions in order to have a better 
understanding of the partial discharge's high frequency signal transfer within a certain bandwidth. 
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Besides the IEC standards, there are applicable IEEE publications as well. The general procedures and 
criteria are not too different from IEC. However, interesting in the IEEE standards are the test voltage crite-
ria for testing at very low frequency (VLF). IEEE splits cable testing into three different groups, i. e. installa-
tion test, acceptance test and maintenance test, each with its related test voltages. 

VLF  
Output  

Waveform 

Cable Rating 
Phase-to-

Phase 

Installation Test  
Phase-to-Ground – U0 

Acceptance Test  
Phase-to-Ground – U0 

Maintenance Test  
Phase-to-Ground – U0 

Si
nu

so
id

al
 

kV rms kV rms kV peak kV rms kV peak kV rms kV peak 

5 9 13 10 14 7 10 

8 11 16 13 18 10 14 

15 19 27 21 30 16 22 

20 24 34 26 37 20 28 

25 29 41 32 45 24 34 

28 32 45 36 51 27 38 

30 34 48 38 54 29 41 

35 29 55 44 62 33 47 

46 51 72 57 81 43 61 

69 75 106 84 119 63 89 

Table 4: MV cable VLF test voltage recommendations 

In general, the recommended testing time according to IEEE 400.2 varies between 15 and 60 minutes. 
Suggested are 30 minutes. For maintenance testing a period of 15 minutes is recommended. 
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VI.1.7 Typical PD Patterns and Tan Delta Levels 

MV class cables are tested in the factory according to common IEC standards. The acceptance level for 
new cable systems is < 2 pC or even less. Therefore, all PD detected on MV cables under applied voltage 
up to 1.5 rated voltage should be considered as a problem within the cable or its accessories. Further anal-
ysis should clarify the cause of such internal PD activity. 

PD Phenomena Typical 
Range 

Further Analy-
sis recom-
mended 

PD Pattern Example 

Void discharge 
 
with low availability of starting 
electrons 
 

<2 pC >20 pC 

Surface discharge  
 

<2 pC >20 pC 

Internal discharges in a 
prefabricated EPR cable joint 

<2 pC >20 pC 

 
Several flat cavities in silicon fat 
due to improper mounting 
procedure 

<2 pC >20 pC 

 
Table 5: Typical PD patterns for MV cables 
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The loss factor values measured on MV cables are usually specified according to the cable insulation sys-
tem and voltage level U0, 2U0 or the tip-up between 2U0 and U0. Please pay attention to the environmental 
conditions as they strongly influence the loss factor and capacitance measurements. Indicative TD values 
are listed with table 6. 

Type of Cable System  New Service Aged Critical Levels 

PE < 0.1 x 10-3 > 2.2 x 10-3 > 2 x 10-3 

VPE-S < 1 x 10-4 > 1 x 10-4 > 1 x 10-3 

VPE-C < 1 x 10-3 > 1 x 10-3 > 1 x 10-3 

VPE-WTR < 1 x 10-3 > 1 x 10-3 > 1 x 10-3 

EPR < 3.5 x 10-3 > 3.5 x 10-3 – 

PVC < 6 x 10-2 (50 Hz) 
< 8 x 10-2 (0.1 Hz) 

> 6 x 10-2 (50 Hz) 
> 8 x 10-2 (0.1 Hz) 

– 

XLPE 0.1 x 10-3 > 2.2 x 10-3 – 

HDPE 0.1 x 10-3 > 2.2 x 10-3 – 

Table 6: Tan delta levels versus insulation system 

VI.1.8 Normative References 

IEC 60502: Power cables with extruded insulation and their accessories for rated voltages from 1 kV 
(Um = 1,2 kV) up to 30 kV (Um = 36 kV) 

IEC 60840: Power cables with extruded insulation and their accessories for rated voltages above 30 kV 
(Um = 36 kV) up to 150 kV (Um = 170 kV) – Test methods and requirements 

IEC 62067: Power cables with extruded insulation and their accessories for rated voltages above 150 kV 
(Um = 170 kV) up to 500 kV (Um = 550 kV) – Test methods and requirements 

IEEE 400: IEEE Guide for Field Testing and Evaluation of the Insulation of Shielded Power Cable Sys-
tems Rated 5 kV and Above 

IEEE 400.2: IEEE Guide for Field Testing of Shielded Power Cable Systems Using Very Low Frequency 
(VLF) (less than 1 Hz) 

IEEE 400.3: IEEE Guide for Partial Discharge Testing of Shielded Power Cable Systems in a Field Envi-
ronment 
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VI.2 Rotating Machines 

VI.2.1 Test Set-up 

A general description of the measurement set-up is given in section III. In this case, the focus is set on the 
rotating machines application. Of main importance is the interconnection between the main grounding of the 
high voltage power supply, i. e. a transformer or resonance test set, and the main grounding of the machine 
frame. The final link from the grounded baseplate of the ICMflex to the ground shield must be as short as 
possible. The high voltage output cable of the ICMflex has to be connected to the phase terminals of the 
motor or generator housing. An installation scheme showing the connections is given with figure 70. 

VI.2.2 Calibration 

Performing high voltage tests, including partial discharge measurements on rotating machines insulation 
systems according to IEC 60270, requires a calibration of the apparent charge. When the complete safety 
procedure as mentioned in section I.3 is accomplished and when the set-up is built-up as described above, 
the calibration can be performed. General procedures are described in the Power Diagnostix's user manual 
for calibration impulse generators. However, the detailed calibration procedure for generators and motors is 
explained below. 

The selection of the relevant charge level to be injected into the measurement circuit is mainly depending 
on the machine's ratings. The main parameter influencing the required charge is the stator windings capaci-
tance. In general, the capacitance is depending on the nominal voltage, number of poles, and the core 
length. It’s important to have a reasonable signal to noise ratio in order to ensure sufficient sensitivity. Se-
lect a value that is approximately 5 to 10 times higher than the present background noise. Typical values 
used for on-site testing are varying from 1 nC to 5 nC, even 10 nC in case of hydro or turbo generators.  

It is recommended to make a calibration using the PD attenuator as well. Due to the properties of the insula-
tion materials and the winding manufacturing techniques of an epoxy mica insulation system, it is known 
that the related partial discharge pulses can produces strong amplitudes. It might happen that the amplifier 
in regular mode cannot handle extraordinary high pulses. Therefore, the ICMflex has an on-board 10 dB 

(2) 

(3) 

(5) 

(6) 

Fig. 70: Rotating machines measurement set-up 

(2) (3) 

(5) (6) 

(1) 

(4) 
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attenuator to be activated in the advanced settings. In this case, you can activate the attenuator and upload 
the relevant calibration file without interrupting the measurement session. The PD attenuator can be 
switched on with the menu item 'Edit->Advanced Settings' of the ICMflex software. 

If access to the neutral connection (star point) is possible, testing of the separate phases can be performed 
as well. In this case, it’s necessary to have an additional calibration as the capacitance to ground will be 
different. On the other hand, injecting a pulse at the neutral terminal and measuring the response at the line 
terminal gives a good idea of the measurement sensitivity.  

 

 

 

VI.2.3 PD Measurements 

Once the calibration procedure is completed and the calibrator (CAL1) has been removed from the test 
specimen, the voltage may be switched on. Please pay attention to the correct settings of the shunt capaci-
tor Csx (low or high) as mentioned in section V.5.3. 

Before switching on the voltage, it’s important to observe the level of the present background noise. Adjust 
the PD gain and LLD level in such a way that the value of the PD amplitude is 50–90% of the maximum 
scale and that the maximum of the background noise is still visible. Do not set the LLD level to 0% in order 
to prevent occupying the A/D converter with converting background noise pulses. Masking the background 
noise up to 80% of its maximum is an acceptable level. 

After switching on the voltage, maybe an additional noise cancellation is required to get rid of disturbances 
caused by the power supply itself or by external sources. Use the gating option for this purpose. Analog 
gating and gating via a fiber optic gating transmitter are possible. Please check section V.8 for more infor-
mation. 

 

Fig. 72: Calibration on a synchronous generator 

Fig. 71: Calibration on a small asynchronous motor 



ICMflex Partial Discharge & Tan Delta Measurement 
52 

Power Diagnostix Systems GmbH ∙ Vaalser Strasse 250 ∙ D-52074 Aachen ∙ Phone +49 241 74927 ∙ Fax +49 241 79521 ∙ www.pdix.com 

The next step of the measurement process is 
searching for the level of the partial discharge 
inception voltage (PDIV). Important for finding 
the PDIV is a sensitive and slight ramp-up of 
the test voltage. A typical test sequence used 
for partial discharge measurements is, for in-
stance, the one for tan delta measuring. In this 
case, the test voltage must be increased in five 
equal steps of 20% of UMAX up to UMAX. The 
maximum voltage level (UMAX) applied to 
ground is the operating line-to-line voltage as 
mentioned on the machines rating plate.  Test-
ing up to the line-to-line voltage does not only 
cover the insulation to ground but also the per-
formance of the inter phases insulation and is 
strongly recommended for acceptance testing 
of new stator windings. Other common UMAX 
levels are up to the operating line-to-ground voltage (UMAX / √3) or up to 120% of the operating line-to-
ground voltage (1.2 UMAX/√3). The maximum test voltage is often agreed between the owner and service 
group and is chosen in respect to the kind of test, e. g. a periodical test or test after repair. 

After the inception voltage is found, phase resolved patterns can be mapped and compared with typical 
phase resolved pattern from known PD origins (see section VI.2.5). The recommended value for the PD 
pattern set time is between 30 s and 60 s when working at power frequency (50 Hz–60 Hz) and about 
1000 s to 1500 s when using very low frequency (VLF) power supplies. 

Together with the pattern the related discharge levels (Qp, QIEC) and the average discharge current (NQS) 
are given. Relevant data for the measurement reports concerning rotating machines are as follows: Sum-
mary table of all test results versus voltage, partial discharge inception and extinction voltage, and the 
phase resolved patterns at each voltage step. The ICMflex software offers an export of those data as a file 
for MS Excel. 

VI.2.4 Step by Step Guide 

In order to simplify the measurements, a step by step option was implemented into the ICMflex standard 
software, which guides users through the required steps that must be fulfilled prior and during the meas-
urement. To enable the step by step guidance, the option must be activated via Edit->Edit Preferences in 

the tab "Miscellaneous". The settings related to the 
step by step measurement can be found on the tab 
"Step by Step Guide". 

1) Voltage cycles to stabilize: The system recognizes 
the applied voltage after having detected the se-
lected number of stable cycles in between the fixed 
voltage tolerance levels. 

2) Cycles per measurement interval: Determines the 
number of averages taken for the tan delta meas-
urement at a certain voltage level after detection of 
a stable voltage level in between the fixed voltage 
tolerances 

3) Voltage measurement tolerance: Tolerance free to 
select in volts [V] of percentage [%]. Based on the 
accepted difference between the theoretical value 
calculated for each voltage step according to the 
machines phase-to-phase voltage entered in the 
machine information 

Fig. 73: Test sequence of a 15 kV winding, PD and TD vs. voltage 

Fig. 74: Preferences window 
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Step 1: The user has to enter the general information such as: 

 

• Work number 

• Machine type 

• Serial number 

• Nominal voltage 

• Phase to be tested 

• Maximum voltage 

• Measured by 

• Approved by 

 

 

 

After filling out each field, the background color of the 
relevant item to be filled changes from red into black 
after confirming by pressing the enter button. The 
nominal voltage to be entered is the operating phase 
to phase voltage of the stator winding. The user can 
make a selection to record date for each phase sepa-
rately or all three phases together (star point connect-
ed). The maximum voltage of the record file is adjust-
able, varying from 0.8 x UN to 1.4 x UN. Once, all the 
required fields are filled out, the upper guide bar will 
indicate “Confirm to Continue”. The settings are saved 
by pressing the “Confirm" button below in the guid-
ance screen. Pressing the “Cancel” button stops the 
step by step procedure.  

If the user confirms the entered data, the upper 
guidance bar will indicate “Completed” in green font 
color and the software continues to the next step. If a 
failure is detected, the forgoing step can be fully 
deleted by pushing the “Clear step” button. 

 

Step 2: Selection of synchronization frequency 

In step 2 the user has to select the synchronization frequency for the measurement within the dropdown list 
“Sync Mode”. Available values are: 

• Normal: 50–60 Hz, power frequency 

• VLF 0.1 Hz 

• VLF 0.05 Hz 

• VLF 0.02 Hz 

Fig. 75: Measurement Setup Guide screen 

Fig. 76: Completed first step 
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According to the synchronization frequency, the set 
time must be chosen accordingly. Power Diagnostix 
has entered recommended set times for each frequen-
cy. The user can chose between selecting the pro-
posed set time or entering a random set time based on 
his own test procedure. Proposed set timees are: 

• Normal: 60 seconds 

• VLF 0.1 Hz : 1500 seconds 

• VLF 0.05 Hz : 1500 seconds 

• VLF 0.02 Hz: 3000 seconds 

 

 

 

 

 

After entering and confirming the set time, the user is asekd to enter the filename. He can do this by push-
ing the button “Filename” in the bottom guidance menu. All measured data at each voltage interval will be 
stored under the entered filename into in the relevant folder at a fixed location at the computer’s hard drive. 

After having selected the filename and desired location at the computer’s hard drive, the second guidance 
bar in the upper guidance screen will indicate “Completed” in green font color and will request the operator 
the continue with step 3.In case a failure is detected, the forgoing step can be deleted by pushing the “Clear 
step” button and the forgoing step can be repeated.  

Step 3: Partial Discharge Calibration (IEC 60270) 

The third step of the measurement guidance will request the user to perform the calibration of the apparent 
charge for the partial discharge measurement. Therefore, he has to connect the calibrator to the winding 
that is going to be measured. The calibrator must be connected according to the example in figure Fehler! 
Verweisquelle konnte nicht gefunden werden.. 

Fig. 77: Synchronization frequency selection 

Fig. 78: File name selection 



ICMflex Partial Discharge & Tan Delta Measurement 
 55 

Power Diagnostix Systems GmbH ∙ Vaalser Strasse 250 ∙ D-52074 Aachen ∙ Phone +49 241 74927 ∙ Fax +49 241 79521 ∙ www.pdix.com 

It is important to consider the signal to noise ratio (STN). According to the present background noise level, 
the user has to inject a sufficiently strong calibration pulse. It must be possible to clearly distinguish the 
calibration pulse and the present background noise level. Common charge levels injected for rotating ma-
chines are 500 pC, 1 nC, 2 nC, and 5 nC. In general, the charge to be injected will be determined by the 
overall capacitance of the stator winding and measurement setup. By performing the calibration this overall 
attenuation gets compensated so that the ICMflex recognizes the same pulse amplitude of the apparent 
charge level that arrives at the phase terminal under test. By double clicking on the upper calibrator line, the 
injected value can be entered in dialog box which will appear on the screen. 

 

Fig. 79: PD calibration 
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Each step that has to be performed to complete the calibration process will be asked by the step by step 
guide. 

1) Connect the calibrator 

2) Start pattern: wait for 10 s (standard acquisition time for calibration) 

3) Double click on the calibrator pulse 

After the injected calibration pulse was entered, the calibration file will be stored into the .flx file with the 
chosen filename in the selected location on the computer. The third guidance bar in the upper guidance 
screen will now indicate “Calibration done” in green font color and request the user to continue with the next 
step by pressing the “Next >” button in lower right corner of the guidance screen. 

Step 4: Switch on the voltage 

The next step in the measurement process is to switch on the voltage. In the upper guidance bar, the re-
quired voltage level will be indicated. It is represented as a phase to ground of phase to phase level. 

From this point in the sequence, the user can turn back to the forgoing step by pushing the button “< Back” 
or go to the next step by pushing “> Next”, at any time. Please note that "> Next" becomes available after 
having completed the forgoing step, only. 

Fig. 80: Calibration sequence 
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The instrument will recognize the voltage level automatically. The voltage tolerance, number of cycles to 
stabilize, and the interval time, i. e. the number of averages per voltage step by means of number of cycles 
per interval, can be selected in the tab "Step by Step Guide" of the preferences panel shown with figure 74. 

Until the desired voltage within the fixed tolerance is reached, the second guidance bar will indicate “Wait-
ing”. Once the required voltage level is reached, the first guidance bar will change into “Voltage reached” in 
green font color and the second guidance bar will show now “Acquire Tan Delta Values”. 

The tan delta measurement will now be performed automatically according to the fixed settings in the pref-
erences. When the number of averages is reached and values are stored for a certain voltage step, the 
second guidance bar will indicate “Start Pattern Acquisition” for performing the partial discharge measure-
ment. The voltage level and remaining acquisition time will always be shown at the left-hand side in the 
lower part of the guidance window. 

 

Fig. 81: Guidance screen while wainting for the voltage 
level to be reached 

Fig. 82: Guidance screen after reaching the test voltage 

Fig. 83: Guidance screen for starting the PD pattern Fig. 84: Guidance screen after completing pattern ac-
quisition 
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The pattern acqusition will be started by pressing the “Start Pattern” button at the bottom of the guidance 
screen (see figure 84). The pattern will be collected according to the fixed set time. Once the pattern is ac-
quired, the second guidance bar will indicate “Pattern Acquisition finished” in green font color. The user has 
to confirm this message by pressing the “Next >” button. The pattern will then be stored under the selected 
filename, per voltage step into one .flx files. If necessary, the pattern can be mapped again in case some of 
the settings have to be adjusted. The pattern stored before will be over-saved by the latest one acquired. To 
map a new pattern, select the “< Back” button first. 

After having confirmed by pressing “Next >”, the guide 
will indicate the next voltage step to be reached. 
When ramping-up the voltage, the user has cross 
check the gain settings for UN and Ux at any time in 
order to not over-range the capacitive voltage dividers. 
When this is the case, a warning will be generated in 
the second guidance bar “U_sn or sx Over-range- 
Decrease U_sn Gain”. The corrective action by means 
of changing the Usn or Usx gain will be indicated as 
well. The maximum voltage level for Usn = 14 VRMS, 
for USX=140VRMS. The actual voltage drops over the 
capacitive dividers can be observed in the upper left 
chart by selecting UACQ, located in the upper right cor-
ner of the chart. After adjusting the gain settings 
properly and detecting the applied voltage within the 
fixed tolerance, the message “Voltage Reached” will 
appear in green font color into the first guidance bar. 
The tan delta records will be made and afterwards, the 
pattern can be acquired again. This procedure must 
be repeated until reaching the last voltage step. 

Besides the gain settings for both voltage dividers, the 
gain for the partial discharge measurement must be 
guarded as well. After reaching a voltage step, please 
check if the present PD activity is within the maximum 
scale of the pattern. If not, increase or decrease the 
PD gain accordingly. 

Once the pattern acquisition for the last voltage step is 
finished, the entire table has been filled out by the 
software automatically. The upper guidance bar will 
show then the message “Measurement finalized” and 
the second guidance bar will ask the operator “Print 
measurement or start new measurement” (see 
figure 86). The test report can by printed by pressing 
the “Print” button located in the lower right-hand cor-
ner of the guidance screen. The report will be printed 
and shown on the computer’s screen. 

Fig. 85: Voltage over-ranging 

Fig. 86: Printing/new test guidance screen 
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After having printed or started a new test, the button “Keep Infos” appears in the lower area of the guidance 
screen. This option is implemented in order to keep the machine details etc. for a consecutive measurement 
on the same machine. For instance, phase V after finishing phase U. So, in case, you only have to re-select 
the phase name, filename and re-do the PD calibration for the relevant phase. For performing the consecu-
tive measurements for the next phase or all tree phases together, for instance, the principle of measuring 
stays the same, i. e. the operator will be guided through the complete sequence again, step by step. When 
pressing the “Clear all” button, all the machine information will be deleted. 

VI.2.5 Typical PD Patterns and Tan Delta Levels 

To simplify the evaluation of all measurement results you can find here some common partial discharge 
patterns versus PD origin and tan delta evaluation criteria as known from rotating machines standards and 
other related literature. Power Diagnostix has experience in PD diagnostic on rotating machines for more 
than 20 years. The following table gives an overview regarding regular PD levels and miscellaneous PD 
phenomena. 

In general, partial discharge activity is inherent to epoxy-mica insulation systems. Compared to other insula-
tion systems were the PD level criteria are specified in the lower pC ranges, such as XLPE for medium and 
high voltage cables or oil-paper insulation system for power transformers, the common PD levels for stator 
winding insulation systems are higher. Epoxy-mica insulation systems also widely tolerate partial discharge 
activity since these systems are developed to be partial discharge resistant for many years. Performing PD 
tests on new machines offers a finger print for further trending over time and will indicate the presence of 
essential design faults, if present. Basically, every significant deviation from regular internal PD can be con-
sidered as a deviation. In this case, the root cause must be investigated. 

As the measured apparent charge levels are depending on many different parameters such as the meas-
urement set-up, measurement frequency, location of the coupler, test voltage, insulation system, and origin 
of the PD location within the winding, there are currently no specific no-go criteria specified. The levels giv-
en below are indicative values. 

 

Fig. 87: Final guidance screen 
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PD Phenomena Typical 

Range 
Further Analy-
sis Recom-
mended 

PD Pattern Example 

Spherical void discharge  
 
with low availability of starting 
electrons 
 

0 nC >500 pC 

 
Surface discharge  
 
at the slot exit 
 
the first stage of field grading 
problem 

0–2 nC >2 nC 

 
Thermally aged main insulation 
 
symmetrical in both half-cyles 
 

<5 nC >5 nC 

 
Slot discharges with machine 
bars 
 
non-symmetrical 
 
predominantly in the negative 
half-cycle 

0 nC >5 nC 

 
Surface discharges at the end 
winding 
 
 

0-2 nC >20 nC 

 

Table 7: Typical rotating machine patterns 
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Specimen Voltage level New Service Aged Comments 

Stator winding 0.2 UN 

UN 

Tip-up per  
0.2 UN 

 

< 30 x 10-3 

< 60 x 10-3 

< 5 x 10-3 

 
@ 50 Hz 

> 30 x 10-3 

> 80 x 10-3 

> 5 x 10-3 

 
@ 50 Hz 

Relevant standard: IEC 60894 
 
Often, different tan delta levels are 
found between various insulation 
types such as global VPI and resin 
rich. 

Single bar 0.2 UN 

UN 

Tip-up per 
0.2 UN 

< 30 x 10-3 

< 60 x 10-3 

2–7 x 10-3 

 
@ 50 Hz 

 Relevant standard: IEEE 286-2000 

Please be aware that is only rea-
sonable to test fully cured coils 

10% of the complete set needs to 
be examined. 

Table 8: Common TD evaluation criteria for rotating machines 

VI.2.6 Normative References 

TS IEC 600034-27: Off-line partial discharge measurements on the stator winding insulation of rotating 
electrical machines 

IEC 600034-27-3: Dielectric dissipation factor measurement on stator winding insulation of rotating elec-
trical machines 

IEC 60894: Guide for test procedure for the measurement of loss tangent of coils and bars for ma-
chine windings 

IEEE 286-2000: Practice for Measurement of Power Factor Tip-Up of Electric Machinery Stator Coil 
Insulation 
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VI.3 Stator Bars 

VI.3.1 General 

The test principle for PD and Tan delta testing on separate stator bars using the ICMflex is very similar to 
testing of complete assembled stator windings. In this case, the coils are not assembled into the magnetic 
stator core, and, hence, an artificial core simulation should be provided in order to ground the straight part 
of the coils. Common materials used for applying grounding electrodes (simulated slot) are conductive ad-
hesive tapes or copper/aluminum bars. It is important that the ground electrode has a similar the length as 
the real stator core. And, it is even more important to achieve and optimal contact of ground electrode mate-
rial used to the slot´s semi-conductive outer layer. In case of copper/aluminum bars are used, pincers can 
be used to ensure the good contact. Coils can be tested completely by bridging the grounded straight parts 
of both coil ends, or tested partly by grounding the straight part of one coil end only. The main purpose of 
tan delta and tan delta tip-up testing is determining the general condition of the coil´s ground wall insulation 
(see section XI.1). The test results mainly show the performance of the slot's conductive outer layer, acting 
as the ground electrode to the magnetic core. 

Generally, stator bars with rated voltage of 6 kV and more are provided of a field grading junction, consist-
ing of a semi-conductive material, e. g. silicon carbide, at the slot-exit area. The function of grading junction 
is controlling the surface field at the coils slot exit proportionally to the distance remote from the core. De-
pending on the rated voltage, this high resistance material with non-linear resistive voltage characteristic 
shall have a certain length and makes an overlap with the slot's linear resistive outer layer. Mostly, the over-
lap between these two layers is made outside the magnetic core. 

With regard to tan delta measurements, these semi conductive materials can influence the overall tan delta 
level, as they show a resistive loss under influence of high voltage potential. Therefore, standards such as 
the IEEE 286-2000 and the new upcoming IEC 60034-27-3 are defining the appliance of guard rings during 
the tan delta test, in order to neglect these resistive losses. Thus, when using guard rings, the aim of the tan 
delta measurement, i.e. checking the performance of the slot corona prevention layer, can be achieved 
without any influence of the results by the semi conductive materials used for the field grading. Therefore, 
Power Diagnostix designed the ICMflex GRC, with guard ring control. For complete windings the contribu-
tion of the resistive losses produced by the semi-conductive material in the overall tan delta level cannot be 
ignored, and, hence, the standard ICMflex can still be used. 

VI.3.2 Test Setup with Standard ICMflex 

The PD and tan delta measurement setup using standard ICMflex is very similar to testing of complete 
windings (see section VI.2.1). Instead of connecting the grounding to the motor or generators frame, it is 
connected to the simulated slot applied on the straight part. In case the entire coil need to be tested, both 
straight parts are interconnected. The high voltage output of the ICMflex must be connected to the coil´s 
HV-conductor circuit. 

 

Coil's HV conductor Interconnection 

Fig. 88: PD and TD testing of resin rich bar 
for a small hydro generator 

Fig. 89: Testing of resin rich bar for an asynchronous motor 

Simulated slot 
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VI.3.3 Test Setup with ICMflex GRC 

Connecting the ICMflex GRC is slightly different from the setup as mentioned in section VI.3.2. First of all, 
the principle of the standard ICMflex is now reverted. The acquisition unit is not under high voltage potential, 
but on ground potential. This modification had to be done in order to be able to provide the instrument with 
the driven guard inputs. The HV electrode on top the of the coupling capacitor needs to be connected to the 
coils high voltage conductor, the simulated slot to the CSX input, and, finally, the main ground of the HV 
transformer to main grounding point of the ICMflex GRC. 

Caution: The test specimen may not touch the floor! To avoid damage of the ICMflex GRC, the specimen 
shall be placed on an isolation mat or must be in hanging position during test. 

Secondly, the guard rings need to be applied to the coils. As preferred material for the guard rings, we rec-
ommend using copper or aluminum conductive adhesive tape. The guard rings need to be applied fully on 
the semi-conductive tape (grey tape or paint) and may not overlap with the slot´s conductive outer layer 
(black tape or paint). The ideal position for the guard ring is between 5 mm and 1 cm remote from the be-
ginning of the field grading junction, viewed from the straight part. The contact resistance from to guard ring 
to coil surface of straight part is here very low, and, hence, the guard ring shall successfully intercept cur-
rents flowing from the semi-conductive layer into the direction of the straight part. 

Once the guard rings are applied, alligator clamps can be used to connect both guard rings to the guard 
inputs of the ICMflex GRC. In case the complete bar should be tested, the guard rings opposite to each 
other can be interconnected. 

 

 

Fig. 91: Test setup with ICMflex GRC 

High voltage transformer

High voltage filter

ICMflex GRC

Stator bar HV connection Guard rings 

Simulated slot 

Fig. 90: Guard ring application 

End of the slot (black tape/paint) 
Semi-con (grey tape/paint) 

Guard ring 

5 mm to 1 cm 

Conductive adhesive copper tape 
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VI.3.4 PD Calibration 

In general, the calibration procedure for the PD measurement is similar to what is described in sec-
tion VI.2.2. Since the test circuit of a single bar has a fairly low capacitance, the required calibration charge 
can be selected to a lower magnitude compared to fully assembled stator windings. Common charge levels 
are in the range of 100 pC to 500 pC. The PD calibrator should be connected between the HV conductor 
circuit of the coil and the simulated slot (GND clamp). 

VI.3.5 PD and Tan Delta Measurement 

The measurement procedure is similar as is described in section VI.2.3 for testing of complete windings. 
Depending on the applicable standard (see section VI.3.7), the procedure and levels for voltage application 
might be different. In the examples below, tan delta measurement results are shown of a 10 kV resin rich 
bar without guard rings and with guard rings applied. Besides the results in strip charts, the tendency of the 
tan delta graph versus voltage clearly shows the effect of the resistive losses of the semi-conductive layer. 

 

Fig. 92: Connectors of the ICMflex GRC 

Fig. 93: Tan delta measurement without guard rings 

Guard inputs 

Input for the 
simulated slot

Capacitance 
range jumper 

GND 

GATE IN 

FO input BAT ON/OFF switch 
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VI.3.6 Typical Patterns and Tan Delta Levels 

The partial discharge patterns are very similar to the ones given for rotating machines in VI.2.5. However, 
for the tan delta measurement, different criteria are applicable. Common levels are specified in the table 
mentioned below. In contrast to testing of complete windings, both IEC and IEEE have specified evaluation 
criteria for the tan delta measurements on single stator bars.   

Currently, these criteria are only valid for resin rich insulation systems and not yet for vacuum pressure 
impregnated systems. Once, the IEC 60034-27-3 is released, it is expected that generalized criteria shall be 
defined for both resin rich and VPI systems. 

For the partial discharge measurement, no criteria are given. According to measurement experiences in the 
past, regular levels for internal PD in well performed new bars are varying from <100 pC up to 500 pC. 
When testing a batch of coils, it is specified that up to 10% of the complete set must be tested. The intention 
is to compare the results and check the conformity. This procedure allows defining average levels per coil 
type, and, hence, any deviations in the sample testing can point problems with the particular bar. 

Table 9: Common TD evaluation criteria for stator bars 

VI.3.7 Normative References 

IEEE 286-2000: IEEE Recommended Practice for Measurement of Power Factor Tip-Up of Electric 
Machinery Stator Coil Insulation 

IEC 600034-27-3∗: Dielectric dissipation factor measurement on stator winding insulation of rotating elec-
trical machines 

IEC 60894: Guide for test procedure for the measurement of loss tangent of coils and bars for ma-
chine windings 

                                                      
∗ Under preparation 

Specimen Voltage level New Service Aged Comments 

Single bar 0.2 UN 

UN 

Tip-up per 
0.2 UN 

< 30 x 10-3 

< 60 x 10-3 

2–7 x 10-3 

 
@ 50 Hz 

 Relevant standard: IEEE 286-2000 

Please be aware that is only rea-
sonable to test fully cured coils 

10% of the complete set needs to 
be examined. 

Fig. 94: Tan delta measurement with guard rings 
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VII Options 

VII.1 Guard Ring Control (GRC) 

In order to meet with the requirements of the existing 
IEEE 286-2000 and the new upcoming IEC 60034 27 3 standard 
for dielectric dissipation factor testing (also known as tan testing) 
on rotating machine stator bars, Power Diagnostix made a re-
design of the existing ICMflex, i. e. the ICMflex GRC "Guard Ring 
Control". Both standards mentioned above define that tan delta 
testing on stator bars should be performed using guard rings in 
order to neglect the resistive losses of the semi-conductive layer. 

The guard ring control option provides two driven guard inputs on 
the ICMflex's acquisition unit. The internal voltage follower circuit 
keeps the surface potential of the semi-conductive layer equal to 
the surface potential of the simulated slot. As a consequence, 
leakage currents created by resistive losses in the semi-
conductive layer flowing from the semi conductive layer into the 
direction of the straight part shall be intercepted, and, thus not 
contribute to the measurement results. 

The ICMflex GRC is optimized for the capacitance range of stator 
bars and for smaller asynchronous induction motors up to Roebel 
bars for larger synchronous turbo generators. Furthermore, the 
embedded voltage divider for up to 30 kVRMS comes with a DAkkS 
(former DKD) calibration certificate. 

The general principle of operation is similar to that of the regular 
ICMflex. It still combines both the PD and Tan delta measurement 
simultaneously, and, hence, the operational software for the 
ICMflex GRC is the same. The main difference with the standard unit is, that the acquisition unit is on low 
voltage potential allowing embedding guard rings. Additionally, the battery is now embedded. Beside oper-
ating on the battery voltage, the instrument can now be operated using line supply as well. 

 

Fig. 95: IMCflex GRC 
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VII.2 Additional PD Input for Noise Cancellation (ICMflex2) 

An ICMflex2 offers the possibility to separate pulses coming from the test object and pulses coming from 
the test voltage source by their polarity. The instrument has a second PD input for PD pulses coming from a 
quadrupole that is built into the HV filter. Another quadrupole is in the path of the coupling capacitor, the 
same position as in the standard ICMflex. With this configuration pulses that are coming from the test object 
have similar polarity, while pulses coming from the test voltage source have opposite polarity (see fig-
ure 98). The acquisition unit analyses the polarity of each pulse and sorts it either in a PD pattern or in a 
disturbance pattern. 

With an additional PD input there are some more 
options selectable within the preferences panel of 
the ICMflex software. The user can determine if 
different filter configurations should be used for the 
main and the auxiliary channel (not recommended) 
and if these two channels should use the same 
configuration or not. 'DSO & Scope View' deter-
mines the behavior of the software when changing 
the channel during acquisition, while 'Pattern Acqui-
sition' shows, which channel is used for the acquisi-
tion of a PD pattern. Furthermore, it's possible to 
change the gating time or to set it to the default 
value of 10 µs. 

The 'DSO Bandwidth' can be switched to 
'IEC 60270'. To have a good time resolution for fault 
location DSO usually works with an extended 
bandwidth of 20 MHz. 

 

 

Fig. 96: Additional input for noise cancellation 'PD2 IN' 

Fig. 97: Multi-channel options 
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To analyze the polarity each pulse must be acquired separately. The acquisition gets triggered when one of 
both channels exceeds the low level discriminator (LLD). At this moment the deadtime starts and at its end 
the positive and negative peak amplitudes of both channels get A/D converted. To get a good pulse separa-
tion both values must be set very carefully. It would be optimal to put the LLD higher than the noise flour, 
but in order to see the noise flour in the acquisition pattern the LLD can also be set that kind, that it triggers 
only the highest noise pulses. If the LLD is set too low, the acquisition triggers too often and not by the PD 
pulses. The deadtime must be set to the length of the pulse oscillation. If it is set too short, the pulse is not 
finished and can trigger double. If it is set too long, it's most likely, that a second pulse come within the 
deadtime, and the lower one gets discriminated. 

Depending on the ICMflex2 installation the two quadrupoles might have different sensitivity. In this case the 
PD gain must be set separately for the two channels. To compare the sensitivity the user can switch to the 
auxiliary channel during calibration and set the gain to a value that the calibrator pulse amplitude is similar 
to that of the main channel. The LLD can also be set individually for each channel. To get equal pulse prop-
erties on both channels, their highpass and lowpass settings should be equal. For that purpose, the sepa-
rate filter configuration can be disabled in the multi-channel options of the preferences (see figure 97). 

The ICMflex2 functions can be used with the two right-hand side screens in the PD and LOC display of the 
ICMflex software. Three additional settings are available with these displays: 
Channel: For toggling between the main and the auxiliary channel in the screen on the upper right-hand 

side. 
Rejection: Offers three different modes of noise cancellation ('First Pol.', 'Peak Pol.', and 'F&P Pol.') 
Dead Time: Time during which a signal is converted and which is reserved to a single pulse. The A/D 

converter does not convert or accept another signal during that time, so that another pulse 
occurring within the dead time is lost. 

In general, there are two different methods of pulse polarity detection. The first method is to decide at what 
polarity the LLD is exceeded first (First Pol.). The second method is to compare the peak amplitude of both 
polarities at the end of the deadtime (Peak Pol.). Additionally, the ICMflex2 offers an AND combination of 
both methods (F&P Pol.). The effectivity of these methods is depending on the repetition rate and the ampli-
tude ratio of the two pulse sources. If there is a high repetition rate, the 'First Pol.' method has a problem if a 
large disturbance pulse follows a smaller PD pulse. If the amplitude of both pulse sources is very different, 
the 'Peak Pol.' method has a problem, if one pulse is overranged in both polarities because the peak ampli-
tudes cannot be compared. Several examples of pulse polarity detection cases are shown with figures 100 
to 103. 

The calibration and PD measurement is usually done with the main channel. If 'Switch to Active Setup' is 
selected for 'DSO & Scope View' within the preferences (see figure 97), the corresponding screens of the 
PD and LOC display can also show the auxiliary channel. But there is no calibration possible, the amplitude 
is shown in percent. For the upper right-hand screen it is possible to choose, if the scope view displays the 
acquisition pattern or the disturbance pattern. The lower right-hand screen always shows the acquisition 
pattern. 

To view the shape of the pulses used for the pattern choose 'IEC 60270' for 'DSO Bandwidth' in the multi-
channel options of the preferences (see figure 97). In IEC 60270 mode the DSO shows the filtered signal 
used for the pattern and the polarity decision. In this mode only the PD gain is relevant. 
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Fig. 98: General connection diagram for ICMflex2 
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Fig. 99: ICMflex2 and line filter LF450 installed on an external coupling capacitor 
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 Pulse from Test Object Pulse from Test Voltage Source 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Pulse from Test Object Followed by Larger Pulse Pulse from Test Object with too high Amplitude 
 from Test Voltage Source within Deadtime (Clipping on both Polarities 
 

 Polarity of first exceeding the LLD Sampled peak values 
 Polarity of maximum pulse amplitude Peak hold 

Fig. 101:     positive polarity on channel 1, negative 
polarity on channel 2;   positive polarity on 
channel 1, negative polarity on channel 2  
=> 'First Pol.' and 'Peak Pol.' have the same 
result 

Fig. 100:     and  have positive polarity on both 
channels  
=> 'First Pol.' and 'Peak Pol.' have the 
same result 

Fig. 102:    positive polarity on both channels;         
   positive polarity on channel 1, negative 
polarity on channel 2  
=> Only 'Peak Pol.' result is correct: 
Pulse gets sorted to disturbance pattern 

Fig. 103:    positive polarity on both channels;
  no decision possible,  
=> only 'First Pol.' result is correct: Pulse 
gets sorted into disturbance pattern 
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VII.3 Gating 

An effective noise reduction is required in case that the ICMflex is used for measurements in an environ-
ment with high frequency (HF) disturbance. HF disturbances, which hamper partial discharge detection and 
which can be handled by the gating function, are, for instance, frequency converter switching pulses, coro-
na discharge, or thyristor firing, whose signals are picked up by an antenna or another sensor. Using the 
analog gating function blinds out such impulse noise. With some applications a current transformer is used 
to acquire the disturbance signal from a ground conductor or from the screen of a signal cable. Electronic 
controlled resonant test sets provide a TTL signal for switching activities (see also section V.8). 

The different signals and gating methods explained below can be used simultaneously. 

VII.3.1 Standard Analog Gating 

An ICMflex with a standard gating function comes with a terminal for a BNC cable that transmits a gating 
signal from an HV filter with a built-in current transformer (CT). The gate level is set by using the ICMflex 
software (see section V.5.1). This option is mainly used for VLF cable testing. 

VII.3.2 Gating via Fiber Optic Link (FO Gating) 

An ICMflex with a gating function comes with an additional terminal for a fiber optic (FO) cable, which takes 
over a signal on HV potential provided by a gating signal transmitter (GST1). The transmitter is included in 
the delivery range if FO gating is ordered. An external signal sensor (e. g. CT1) is connected via a BNC 
cable to the 'GATE IN' terminal of the GST1. 

If disturbances like switching of a relay or thyristor firing have a known source, it might be possible to create 
a TTL signal prior to the disturbance. This signal can be used to blind out the PD measurement path. If a 
TTL signal is available, it can be provided to the GST1 via a BNC cable that is connected to the ''TTL IN' 
terminal. 

 

Fig. 104: Gating inputs 

Analog 
GATE IN 

only! 

Fiber optic 
GATE IN 
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VII.4 Bypass 

If the test object's capacitance is too high, an ICMflex for tan δ measurements can be fitted with a Cx bypass 
to avoid overstressing of the shunt capacitor. With an active bypass loss factor measurements are disabled 
but PD diagnostic is still possible. 

VII.5 Built-in RPA1L 

For applications with high requirements in sensitivity the ICMflex can be equipped with a 
built-in preamplifier (RPA1L), which reduces the instruments input sensitivity to 15 µV. It has 
a switchable pre-gain of 1, 10 and 100. The ICMflex with preamplifier has an extended gain 
list (4 to 80000). From 4 to 100 the pre-gain is 1, from 200 to 1000 the pre-gain is 10, and 
from 2000 to 80000 the pre-gain is 100. The range of the DSO gain is also influenced by the 
pre-gain, the total DSO gain can’t be lower than the pre-gain. 

If there is no correct connection or a short circuit in the cable from the ICMflex to the RPA1L, 
the software shows a warning by filling the background of the 'PD Gain' setting with a red 
color. 

If an ICMflex2 is equipped with a built-in preamplifier, a second RPA1L is needed to be in-
stalled as close as possible to the quadrupole in the HV filter. 

 

 

 

VII.6 External Battery Adapter 

Power Diagnostix offers an external battery adapter for connecting larger batteries to the instrument, in-
stead of using the standard ICMflex battery BAT2A. 

 

Fig. 105: Jumper in bypass mode 

Fig. 106: Extended gain list 
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VIII Miscellaneous 

VIII.1 Maintenance 

The ICMflex does not require any maintenance on a regular basis. There is no fine adjustment on a regular 
basis required, as the partial discharge measurement is a relative measurement that is calibrated with a 
reference source (charge calibrator, CAL series) prior to a measurement. The instrument receives high 
frequency PD signals and quotes them with a certain pC level based on the calibration made prior to the 
testing. In case of daily usage, it is recommended to calibrate the impulse generator on an annual basis to 
ensure that its output signal remains within the recommended boundaries. The only part of the instrument 
that requires calibration is voltage measurement. The voltage calibration is also recommended to be cali-
brated on yearly base, unless the calibration policy of the customer defines a different time interval. 

Care should be taken that the instrument stays clean. Any conductive contamination on the corona cage, 
and mainly on the connection of the reference capacitor to the corona cage might result into leakage cur-
rent, which can influence the tan delta measurement results. 

VIII.2 Transporting and Shipment Instructions 

Generally, we recommend transporting the high voltage filter and the ICMflex in vertical direction in order to 
prevent problems with the HV and GND connections of the reference capacitor of the ICMflex and the 
damping capacitor of the T-filter. 

In case a unit needs to be returned to the factory, make sure the acquisition unit is packed safely. Please 
use the provided boxes for the shipment. As the units are relatively large, shipment by a forwarding agent is 
the recommended mode of transportation. If possible, declare the instrument as 'used instruments for eval-
uation' at a relative low value. Consult Power Diagnostix for further details. Additionally, Power Diagnostix 
may provide you with a temporary replacement unit, in case of urgent needs. 
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VIII.3 Declaration of Conformity 
 
 
 
 
Power Diagnostix Systems GmbH 
Vaalser Strasse 250 
52074 Aachen 
Germany 
 
 
 
 
 
declares, that the instrument as specified below, meets the requirements of the standards and/or normative 
documents as listed below. 
 
Subsequently the instrument complies with the requirements of the EMC directive 2004/108/EC. 
 
 
 
Product: ICMflex 
 
Description:  Partial discharge detector for use in high voltage test areas 
 
Standards: EN 61000-6-1, EN 61000-6-2 
 EN 61000-6-3, EN 61000-6-4 
 EN 61010-1, 2006/95/EC 
 
 
Date:  
 
 
 
 
 
Markus Söller (Managing Director) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Remark: Since the measurement of partial discharge pulses is done in frequency bands partly occupied by 
radio transmission, and since further test leads may act as antennas, disturbance free measurements may 
require well shielded environments and/or additional filter techniques. 
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IX Technical Data (Standard Version) 

Mains supply: Battery operated 

Power requirements: Approx. 20 VA 

Operation: Remote controlled via ICMflex software 

PD input impedance: 10 kΩ // 50 pF 

PD input sensitivity: < 150 μV, corresponds to 0.2 pC (without built-in preamplifier) 
(without test object) < 15 µV, corresponds to 0.02 pC (with built-in preamplifier) 

PD lower cut-off (-6 dB): 40, 80 or 100 kHz (software controlled) 

PD upper cut-off (-6 dB): 250, 600 or 800 kHz (software controlled) 

PD A/D converter: 8 bit (±7 bit) 

PD location (TDR): 8 bit, 100 MS 

Specimen cable length: 10 to 25000 m, for a sample rate of 320 µs & vc = 160 m/µs 

Localization precision: 1 m + 0.1% of the cable length 

Voltage measurement: 16 bit, 100 MS 

Voltage values displayed: URMS value, Û/√2 value, crest factor 

Tan delta resolution: 5 x 10-5 

Tan delta precision: 1 x 10-4 

Synchronization: External on reference voltage 

Synchronization range: 20 Hz–510 Hz (normal mode) 
0.1 Hz, 0.05 Hz, 0.02 Hz (VLF) 

Operation temperature: 0–55°C (non-condensing) 

Interfaces: Bluetooth  (921 kBit/s) 
Fiber optic serial link (921 kBit/s) 
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X Weight and Dimensions 
Type Rated 

Voltage 

Ur (RMS) 

Max. 
Weight 

kg 

Height 
 

mm 

Width 
 

mm 

Length 
 

mm 

Comment 

Measurement 
System 

      

ICMflex 30 kV 15 600 350 350  

ICMflex 50 kV 40 800 350 350  

ICMflex 100 kV 45 910 350 350  

ICMflex  150 kV 50 1440 350 350  

ICMflex >200 kV  - - - To be installed on separate HV 
reference capacitor of min. 1 nF. 

ICMflex2 >200 kV  220 365 350 To be installed on separate HV 
reference capacitor of min. 1 nF. 

Filter Unit       

T30 30 kV 33 610 350 350  

T50 50 kV 40 800 350 350  

T100 100 kV 53 985 350 350  

T150 150 kV 65 1200 350 350  

LF450 - 130 512 450 450 To be installed on separate HV blocking 
capacitors of min. 10 nF. 
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XI Appendix 

XI.1 What is the Loss Factor (or Dissipation Factor) tan δ? 

Building high voltage equipment requires using insulation material. Commonly used insulation materials 
show losses due to resistive currents or polarization currents of dipoles. Often, the magnitude of these loss-
es can be used as an indicator for the quality of the insulation. 
Especially, in case of assessing the quality of aged insulation, 
increased dissipation indicates oil or paper decomposition (trans-
formers), humidity, electro-chemical processes (water-trees in 
polymeric cables), or, for instance, heavy partial discharge. 

With an ideal capacitor (C), the resistance of the insulation materi-
al (dielectric) is infinitely large. When an AC voltage (U) is applied, 
the current (IC) leads the voltage by exactly ϕ = 90°. A component 
close to this ideal capacitor with a negligible resistance should be 
used as standard (or reference) capacitor for the reference branch 
of a dielectric loss analyzer. 

Technical insulation systems are usually built of less perfect insu-
lation material resulting in a small current (IR) in phase to the sup-
plied voltage (U). This current can be described by a parallel resis-
tor (R) to an ideal capacitor (C). The phase difference between the 
real current (I) and the ideal current (IC) can be described as 
phase angle: ‘δ’.  

Because P = Q · tan δ, the losses which are proportional to tan δ, 
will usually be given as a value of tan δ to express the quality of an 
insulation material. Therefore, the angle δ is described as loss 
angle and tan δ as loss factor. 

With a good insulation of low-loss capacitors (δ ~ 0° and ϕ ~90°), the ideal current 'IC' is approximately 
equal to the real current 'I'; resulting in a negligible deviation of the values tan δ and cos ϕ. In Europe, the 
dissipation factor tan δ is mostly used to describe the dielectric losses, while in North America the Power 
factor (PF = cos ϕ) is commonly used. The software of the ICMflex displays both values together with the 
calculated capacitance, the voltages, and the frequency. 
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XI.2 Troubleshooting 

The personal computer cannot find the ICMflex 

If no communication between the ICMflex and the software can be established, please reboot the control 
computer and check 

- if all necessary drivers are installed properly (see section IV.2 and IV.3) 
- if the battery is charged. 

In order to do so, measure the DC voltage when trying to establish a connection to the ICMflex. Therefor, 
connect the battery to the ICMflex as shown with figure 107 (please check the polarity first). If the voltage is 
10.5 Volts or even less, the battery has to be recharged. If the voltage drops down even after charging for 
at least six hours, the battery is faulty. 

 

Fig. 107: Testing the voltage level of the battery 
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The ICMflex application window appears very small on high resolution monitors und Windows 10. 

On PCs running Windows 10 with the Creator's Update of 2017 the 
ICMflex application window may appear very small on high resolution 
monitors. To enlarge the display size of the software, please take the 
following steps: 

1. Right-click on the application short cut on the desktop. 
2. Choose "Properties" from the context menu, which will open the 

Properties window. 
3. Enable "Override high DPI scaling behaviour" and set "Scaling 

performed by" to "System" on the "Compatibility" tab. 
4. If you have administrator rights, you can change the settings for 

all users by clicking the corresponding button. 
5. Approve the change by clicking "OK". 
 
 
 
 
 
 
 

 

Fig. 108: Properties window 

Fig. 109: Desktop before and after change of scaling behavior 


